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Introducción

“La fotografía es un procedimiento de fi jación de trazos luminosos sobre una 
superfi cie preparada a tal efecto. El estatuto iconográfi co de la imagen fotográfi ca 
se fundamenta en esta naturaleza fotoquímica: la luz incide sobre una sustancia 
o emulsión fotosensible provocando una reacción que altera alguna de sus 
propiedades. Lo más común consiste en que la acción de la luz ennegrece unas 
sales de plata.”(Fontuberta J.) [1] 

Etimológicamente, el término fotografía proviene del griego φως phos 
(“luz”), y γραφίς grafi s (“diseñar”, “escribir”) que, en su conjunto, 
signifi ca “diseñar/ escribir con la luz”; nosotros, con esta tesina, a la 
inversa, intentaremos utilizar la fotografía para comprender la luz, 
forjando un nuevo término Fotoagnosis (leer la luz), y pretenderemos 
analizar fotografías para llegar a las diferente fuentes luminosas y 
controlarlas.
Esta tesina nace de la voluntad de conciliar las pasiones mas grandes 
de quien escribe: la fotografía, la arquitectura y el medio ambiente. Por lo 
tanto, se plantea como una investigación de fotografía aplicada para 
el control de la luz en un punto (punto de saque) en relación con el 
entorno. El trabajo partirá con el estudio de la luz y sus componentes, 
pasando por el análisis de los equipos fotográfi cos con la fi nalidad de 
comprender mejor los instrumentos que nos proponemos utilizar, e 
intentaremos fi nalizar con la formulación de un método para el estudio 
de un lugar usando como medio de control aparatos fotográfi cos.En 
particular, nuestro estudio se propone abordar las posibilidades que la 
fotografía digital y la fotografía hemisférica ofrecen como instrumento 
real para analizar un lugar en relación a la luz natural. 

Hoy en día, varias ciencias utilizan fotografías para estudiar los 
cambios y la evolución de distintas “especies” o “cuerpos”. En 
el campo de la investigación farmacéutica, por ejemplo, se suele 
comparar imágenes de microscopio de células afectadas por bacterias 
y virus, para estudiar la evolución de éstos intentando comprender las 
causas de las enfermedades y desarrollar sus remedios. En medicina, 
en particular en Dermatología y Oncología, se suelen confrontar y 
medir fotografías cutáneas para estudiar los cambios de manchas 
en la piel y tumores. En Ortopedia se consultan imágenes de rayos 
X (radiografías) para verifi car el esqueleto. En Astronomía, se suele 
analizar imágenes de telescopio para evaluar la distancia, la edad 
y el tamaño de las estrellas y cuerpos celestes. En Meteorología se 
analizan fotografías satelitales para  estudiar el movimiento de las 
nubes y prever las condiciones atmosféricas. 
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En particular, tomaremos como base de nuestro estudio la metodología 
de investigación ya consolidada desde los años ‘70 en Agronomía 
y Ciencia Forestal, para el análisis de las copas de los árboles y el 
sotobosque de espacios cultivados y selvas, que se suele conocer con 
el nombre de Técnica de la Fotografía Hemisférica.
Actualmente, con el desarrollo y avance de las diferentes energías 
renovables, la incorporación en los nuevos Códigos técnicos de 
parámetros ambientales y la mayor sensibilidad hacia el medio 
ambiente, las técnicas de análisis de imágenes se han vuelto muy 
presentes también en el campo de la Arquitectura. En particular, 
tendremos como referencia varios estudios que se están desarrollando 
en el mundo sobre este específi co tema, mirando con particular interés 
lo que se está experimentando por el departamento de arquitectura de 
la Universidad de Tokio, por el equipo de investigación de Santiago 
Torres.  

La tesis se divide en diez capítulos que abordan diferentes temas, 
algunos teóricos y otros más prácticos y experimentales. Los capítulos 
1 a 5, se ocupan de presentar de forma teórica y general los conceptos 
y las herramientas que se utilizarán en los capítulos siguientes. En los 
capítulos 6, 7 y 8, más prácticos y específi cos, intentaremos desplegar 
el método que hemos utilizado y desarrollado para el análisis 
fotográfi co de un ambiente arquitectónico, además presentaremos 
paso a paso los softwares utilizados, con la intención de que cualquier 
lector pueda realizar el experimento. El capítulo fi nal presenta de 
forma breve, ciertos instrumentos usados para el análisis de la luz 
solar en las instalaciones de paneles fotovoltaicos y solares térmicos, 
que se encuentran hoy en día en el comercio.  

Cabe agregar, que la fase experimental de este trabajo ha sido 
posible gracias al interés del equipo de investigación AVENUES de 
la Universidad Tecnológica de Compiègne, en el norte de Francia, 
que ha valorado nuestra hipótesis de trabajo y ha puesto a disposición 
tiempo, materiales y recursos para el desarrollo de la investigación. 
Por esto aprovechamos la ocasión para agradecer a profesores, 
doctorandos, estudiantes y personal de secretaria de la Facultad de 

Ingeniería de la UTC, por su disponibilidad y por haberme acogido 
y ayudado en mi estancia en Compiègne. También agradecer a mi 
familia, por el apoyo y los recursos, a Verónica por haber sido un 
auxilio fundamental en la elaboración del texto y por el soporte 
moral.

  

[1]. Fontuberta J., 1995, Fotografía: Conceptos y procedimientos, una propuesta 
metodológica, G.Gili, Barcelona 
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La luz

La luz es la base de la fotografía. Como dice la misma palabra fotografía 
(escribir con la luz), la iluminación es fundamental en la disciplina 
fotográfi ca. Por ello, hemos pensado incluir en esta tesis una pequeña 
introducción y un rápido repaso de fotometría.
Una fotografía no es nada más que luz canalizada que llega hasta 
una película o un sensor, en el caso de fotografía digital, a través del 
objetivo de la cámara y que nos da una imagen fotográfi ca, con la que 
estamos tan acostumbrados.
¿Qué es la luz? La luz es la parte de las radiaciones electromagnéticas que 
llega a la Tierra y es visible por el ojo humano. Lo que habitualmente 
defi nimos como luz es simplemente una porción de los rayos de 
energía que irradia el sol u otra fuente de radiación.
A la Tierra llegan una gran variedad de radiaciones con diferentes 
longitudes de onda, algunas fi ltradas por la atmósfera. La mayoría de 
éstas no son visibles por el ojo humano y casi no nos damos cuenta, 
pero sí que son perceptibles por nuestro cuerpo. La totalidad de las 
radiaciones se llama espectro electromagnético y van desde radiaciones 
de menor longitud de onda, como los Rayos Cósmicos, Rayos Gamma y 
los Rayos-X, hasta ondas electromagnéticas de mayor longitud, como 
las ondas Radio, pasando por ondas intermedias como la luz visible.
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Esquema longitud de onda: http://eosweb.larc.nasa.gov/EDDOCS/Wavelengths_for_Colors.html 

    La mayoría de estas radiaciones no son directamente perceptibles 
por el ojo humano, que es sensible solamente a una pequeña banda, 
entre una longitud en el vació de 380nm y 780nm (un nanómetro = 

10-9 metros)1. Distinta longitud de onda aporta a nuestro ojo distinta 
sensación de color. La longitud de onda más pequeña coincide con 
una luz violeta-morado, entre 380nm y 450nm, pasando por el azul-
verde, 450nm y 580nm, el amarillo-naranja, entre 580nm  y 650nm, 
hasta llegar a tonalidades rojas cuando más nos acercamos a los 700-
780nm. 
Cuando se presenta una mezcla de todas las longitudes de onda 
visibles, la iluminación es “blanca”. Los colores del espectro, violeta-
azul-verde-amarillo-naranja-rojo, siempre están presentes en las luz 
blanca, sea natural o artifi cial. Con longitudes de onda inferiores a 
380nm (violeta), se dice que tenemos rayos ultra-violetas y con longitudes 
superiores a 780nm (rojo) tenemos rayos infrarrojos o térmicos.
Así como el ojo humano, la mayoría de las cámaras fotográfi cas 
comunes y de las películas tradicionales son sensibles a la longitud de 
onda visible. Si bien, las películas son más sensibles que nuestro ojo 
percibiendo los rayos ultravioletas inferiores a longitud de 250nm2. 
Por esto, muchas veces se utilizan fi ltros que absorben los rayos 
ultravioletas, de modo que la imagen obtenida tenga apariencia más 
real. 
Hay cámaras y películas que son sensibles a las ondas largas, más o 
menos 900nm, y se usan normalmente con fi nes científi cos, cámaras 
infrarrojas o cámaras térmicas.

1.1 La luz y las superfi cies

No siempre la luz reacciona del mismo modo cuando encuentra una 
superfi cie. Su comportamiento depende de varios factores, entre los 
que podemos mencionar: el tipo de luz, el tipo de material, textura, 
color, espesor y densidad.
Cuando una luz incide sobre un cuerpo, éste absorbe una parte del 

1  Un nanómetro equivale a una millonésima parte del milímetro
2  Este se nota cuando sacamos fotografías de paisajes lejanos, las partículas 
de la atmósfera dispersan la radiación solar con longitud de ondas cortas, y el cielo 
aparece más azul y los paisajes de segundo plano aparecen más azulados. El efecto 
es especialmente predominante cuando los paisajes se encuentran a gran altura o 
cerca del mar.
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espectro, una parte se refl eja y otra parte se trasmite. Si una superfi cie 
absorbe y refl eja la luz y no la deja pasar, el cuerpo se dice opaco. 
Cuando una superfi cie, como el vidrio o el agua, transmite casi toda la 
luz incidente, se dice transparente, mientras que si deja pasar solamente 
una parte de la luz, como el cristal opaco o la misma atmósfera 
terrestre, se dice translúcida.
Si una superfi cie  refl eja todos los colores por igual, en la misma 
proporción, decimos que el objeto es blanco o gris. Si refl eja una 
determinada gama de longitudes de onda y absorbe otras, el objeto 
es coloreado. Si el material es de un color concreto se refl eja las 
longitudes de onda de ese color y las restantes longitudes de onda de 
la luz quedan absorbidas. Si la luz es absorbida en su totalidad, éste 
será un cuerpo negro. Por lo tanto, podemos considerar el color como 
luz, como el resultado de restar una determinada parte del espectro 
visible a la luz blanca. 
Nuestros ojos son sensibles a tres colores: verde, rojo y azul; la visión 
de todas las variedades de colores se produce como resultado de la 
combinación de estímulos nerviosos de estos tres tonos.
Si una superfi cie es transparente o translúcida, dejará pasar la luz que 
contenga su misma longitud de onda. Por ejemplo, un cristal blanco 
dejará pasar el entero espectro de luz3, mientras que un cristal azul 
permitirá el paso de longitudes de onda azules y será casi opaco ante 
una luz verde o roja4. 

La textura del material también infl uye en la manera de refl ejar la luz. 
Distinguimos principalmente dos tipos de refl exión dependiendo del 
tipo de material: refl exión especular y refl exión difusa. 
Si la superfi cie es lisa y refl ectiva, como un metal, actuará como un 
espejo y casi toda la luz se refl ejará en la misma dirección, mientras 
que una superfi cie mate, como la de la piel o de una cáscara, dispersará 
la luz uniformemente en todas las direcciones.
Cuando una luz atraviesa un material transparente de forma 

3  Transmisión directa: un rayo de luz que incide perpendicularmente a la 
superfi cie de esos materiales prosigue su trayectoria con igual intensidad. [7]
4  Transición selectiva: una superfi cie permite el paso de ciertas longitudes 
de onda de un rayo de luz. [7]

oblicua, ocurre una desviación de la luz conocida como refracción. 
Una luz al pasar por una superfi cie más densa que el aire, como 
puede ser un cristal, se mueve más despacio y cambia ligeramente 
su dirección. La refracción solamente desvía la luz oblicua, no la que 
incide en la superfi cie en ángulo recto. Eso es la base de las ópticas 
fotográfi cas, donde parte de la luz, al pasar por la lente, se desvía más 
perpendicularmente a la superfi cie de la luneta.

Refracción, desviación de la luz cuando encuentra atraviesa 
un material transparente
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1.2 Luz directa y luz difusa
 
La luz se propaga en línea recta y en todas las direcciones. Si un rayo 
de luz que sale desde una fuente cualquiera de iluminación, como el 
sol o una bombilla, llega a una superfi cie sin interferir con ningún 
obstáculo, directamente, se dice que tal superfi cie está iluminada de 
forma directa. En presencia de luz directa la sombra que proyecta 
la superfi cie iluminada por una fuente compacta será muy intensa 
y muy bien perfi lada, el borde de esta sombra es recortada y las 
diferencias de luminosidad están acentuadas por el drástico paso de 
luz a sombra. Normalmente, en fotografía, la presencia de luz directa 
proveniente de una fuente de luz puntual se defi ne como luz dura o 
contrastada. Cuanto más concentrada es la fuente o mayor la distancia, 
más direccional es su luz.
Si un rayo que sale de una fuente de iluminación llega a una superfi cie 
después de haber pasado por un obstáculo, indirectamente, se dice que 
tal superfi cie está iluminada de forma indirecta o difusa. Si se interpone 
un obstáculo entre un objeto y una fuente de luz, no quiere decir que 
el objeto no esté iluminado, ya que la luz puede llegar a él por refl exión 
o por fi ltraje. Por ejemplo, si colocamos entre un cuerpo y una fuente 
lumínica una superfi cie translúcida, la superfi cie translúcida permitirá 
que pase la luz pero también la dispersará propagándola en todas las 
direcciones. Si pensamos en un cielo cubierto o en cualquier punto 
que está en la sombra, donde no llega directamente la luz del sol, no 
nos encontramos con una condición de oscuridad pero sí una luz más 
suave, esto se explica porque el cielo, la atmósfera y las nubes actúan 
como superfi cies que refl ejan la luz directa del sol. El objeto que está 
siendo iluminado por la luz indirecta proyecta una sombra con un 
perfi l más suave, atenuado y cuyos bordes se desdibujan. En presencia 
de luz indirecta, el paso de la luz a la sombra  es gradual.
Podemos encontrar también condiciones de luz difusa, cuando una 
luz direccional se refl eja contra una superfi cie clara como una pared 
blanca.   

1.3 Características de la luz

La distinción entre luz difusa y luz directa es una de las características 
básicas de cualquier tipo de luz. Esta es la que normalmente en 
fotografía se denomina calidad de luz: luz dura o contrastada y luz suave o 
difusa. Otras características son: la intensidad, la dirección y el color. 
Son tres los factores que infl uyen en la intensidad de la luz y que 
hay que tener en cuenta. 1) el fl ujo emitido por la fuente, que expresa la 
cantidad de luz emitida por unidad de tiempo y depende de la potencia 
de la fuente y de su rendimiento. El fl ujo de emisión se mide en lumen; 
2) La illuminancia es el fl ujo por unidad de superfi cie. Se mide en lux 
y, en el caso de una fuente puntual, disminuye como el cuadrado de la 
distancia entre la superfi cie y la fuente. 3) La intensidad  de luz refl ejada, 
pues la intensidad de luz que refl eja una superfi cie. Esta depende del 
ángulo que forma con la dirección de luz y de la capacidad de la 
superfi cie de refl ejar la luz. Este último se llama coefi ciente de refl exión 
o refl ectancia5. En general, se utiliza la luminancia (cd/m2), que es 
una magnitud direccional, a diferencia de la illuminancia, magnitud 
hemisférica. 
No toda la luz tiene el mismo color. La mayoría de luces que 
normalmente se usan despiden una luz blanca, que tiene un espectro 
continuo, una mezcla de todos los colores. El efecto cromático que 
emite la luz a través de una fuente luminosa depende de su temperatura, 
la que defi nimos temperatura de color. La temperatura de color se mide 
a través del termocolorímetro en grados Kelvin6. Inversamente a 
como estamos acostumbrados a pensar, a temperaturas más bajas se 
intensifi ca la cantidad de amarillo y rojo en la luz (luz cálida), mientras 

5  Coefi ciente que varía de 0 a 1. El valor 1 indica que una superfi cie 
refl eja el 100 % de la luz de le llega. En la práctica, no existe un material de 
coefi ciente 1, por ejemplo la nieve, material con alto coefi ciente de refl exión 0,95, 
quiere decir que tiene una capacidad de refl ejar el 95 % de luz incidente. Un 
papel blanco un 70-80%, el terciopelo negro un 1%, el ladrillo rojo un 20%, ect… 
El fotómetro de la cámara considera una refl ectancia media del 18%, por esto 
en el caso de una superfi cie que tenga una refl ectancia muy alta o muy baja, la 
medición será incorrecta.    
6  La temperatura, en escala absoluta, a la que se debe calentar el cuerpo 
negro ideal para compensar el color de la luz.
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a temperaturas más altas se tendrá una luz más azul (luz fría).
La luz emitida por una vela mide aproximadamente 1800 grados 
Kelvin, la luz del sol al mediodía mide 5500 K y por la tarde 4300 
K. En fotografía, es muy importante esta característica de la luz en 
relación a que el ojo humano se adapta rápidamente a los cambios de 
colores y casi sin darse cuenta, en cambio, la cámara graba todos los 
cambios cromáticos. Por esta razón, existen películas especiales para 
las diferentes temperaturas de color. Las películas normalmente están 
hechas para una temperatura de 5500 K, que equivale a la luz del día 
en un cielo del norte7. Para corregir las diferentes dominantes de color, 
de las lámparas o en dependencia de las condiciones de la luz natural, 
se puede aplicar un fi ltro al objetivo de la cámara o interponerlo entre 
la fuente y la escena.  

Escala de temperaturas de color http://aquafl ash.blogspot.com/2008/10/2-imitando-la-luz-del-sol.
html

7  Las películas de color para luz diurna (ISA 100) están productas 
teniendo en cuenta una mezcla de sol y luna en el cielo de Washington hacia al 
atardecer) [1].

1.4 La luz diurna

La luz diurna es más variable que las fuentes de luz  artifi ciales. Su 
calidad varía desde luz directa, muy dura y contrastada, de la luz del 
sol en un día despejado hasta condiciones de luz muy suave de luz 
indirecta, en un día  totalmente nublado, pasando por calidades de 
luz variable y mixta en días de cielo parcialmente nublado. Según 
las horas del día y de las condiciones meteorológicas, la luz natural 
del sol asume coloraciones diferentes. La temperatura del color varía 
desde 18000 K, luz que llega a un sujeto que está a la sombra y está 
iluminado por el cielo azul, pasando por unos 10000 K, cielo azul, 
9000 K, cielo parcialmente nublado, 5000 K, luz blanca directa de 
mediodía, hasta llegar a temperaturas bajas de 3000 K al amanecer 
o al anochecer.
La dirección del sol varía cada día, con su trayectoria cotidiana de 
este a oeste, sea su azimut y altura en los diferentes días del año. En 
invierno, el sol estará más bajo y más cerca del horizonte mientras en 
verano el sol se encontrará más alto y vertical. Hay que pensar que, 
dependiendo de la latitud, la posición del sol, y en consecuencia la 
sombra que proyecta, puede variar notablemente. Entre los trópicos, el 
sol de mediodía puede hallarse al norte o al sur según la temporada.
Por esto, es recomendable, antes de fotografi ar con luz natural, 
conocer bien las variaciones que la iluminación natural supone.
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El movimiento solar

Como todos sabemos, no es el sol que se mueve alrededor de la Tierra 
si no la Tierra que se mueve en relación al sol, por lo tanto, no es 
muy correcto hablar de “movimiento solar”, sino más bien de “movimiento 
aparente del sol” en cuanto, aparentemente, visto desde la Tierra, es el 
sol que se desplaza sobre la bóveda celeste.
El movimiento solar aparente, con el movimiento de las nubes y la 
presencia de obstrucciones, determinan la dirección de los rayos 
solares, de la luz natural y de la intensidad con la cual la radiación 
llega a la Tierra.
Por lo tanto, no es el sol que se mueve, sino nuestro planeta que se 
desplaza y gira en relación al sol. Los principales movimientos de la 
Tierra son el movimiento de rotación y el movimiento de traslación. Estos dos 
movimientos juntos, son los que hacen variar la inclinación de los 
rayos solares y que determinan la trayectoria del sol visto desde un 
determinado punto del planeta.
Hablamos de movimiento de rotación en relación a la revolución 
que la Tierra, en el periodo de un día, realiza alrededor de su eje de 
Este a Oeste. Por esta razón, cualquier punto de nuestro planeta está 
iluminado durante el día y oscuro por la noche. Así también, para 
entender mejor la relación día-noche hay que considerar la inclinación 
del eje terrestre, que no es perpendicular a la eclíptica1 sino inclinado 
en 66,5º o con respecto a los polos geográfi cos de 23,5º y el hecho que 
el eje siempre se mantiene paralelo a sí mismo. Cualquier paralelo 
de la Tierra estará iluminado de modo diferente a lo largo del año, 
pues en cualquier punto del planeta la posición del sol cambiará en 
relación al periodo del año y de la latitud. 

1  Plano hipotético sobre el que se da el movimiento elíptico de traslación 
de la Tierra alrededor del sol. 
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http://www.meteoliri.it/meteoliri_site/
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El sol, amaneciendo a oriente y atardeciendo a occidente, describirá 
un movimiento aparente diurno caracterizado por arcos diferentes 
que intersecan el horizonte en puntos distintos dependiendo del mes. 
Cuando la Tierra esté en la zona de equinoccios, el sol amanecerá 
exactamente al Este y se pondrá exactamente al Oeste, mientras que 
en los solsticios de invierno y verano el sol describirá arcos que estarán 
desplazados de 23,5º hacia el Sur o el Norte.
Hablamos de movimiento de traslación en relación a la rotación 
elíptica que realiza la Tierra alrededor del sol cada 365,25 días. El 
movimiento de la Tierra alrededor del sol es ligeramente elíptico, pero 
no infl uye de forma sensible, por lo que decimos que este movimiento 
es prácticamente circular. La energía que recibe la Tierra no depende 
de la distancia que existe con el sol, como consecuencia de su posición 
en la elipse, sino de su inclinación. De hecho, las estaciones dependen 
de la cantidad de atmósfera que tienen que atravesar los rayos solares 
antes de llegar a la Tierra, dependiendo de la inclinación de la 
superfi cie que recibe la energía.
Cuanto más al norte o a sur se ubique un emplazamiento, la trayectoria 
del recorrido solar tenderá a inclinarse respectivamente más hacia el 
sur o hacia el norte. Las diferencias de horas solares serán mayores en 
la medida que el emplazamiento este más alejado de la línea Ecuatorial 
y según la estación en que se encuentre el hemisferio. Por de bajo o 
por encima de los trópicos el sol nunca llegará a estar perfectamente 
perpendicular a la Tierra. Por encima del círculo polar ártico o por 
debajo del círculo polar antártico habrá días de 24 horas o días con 
total ausencia de sol.
 

2.1 Proyecciones solares: bidimensional

Un modo muy inmediato para representar el movimiento aparente 
del sol es en forma tridimensional: una superfi cie plana dentro de una 
semiesfera. Para ubicar el sol en esta bóveda se hace uso del ángulo 
acimut2(α), y el ángulo de altura3(γ).

Esquema tridimensional de la bóveda celeste con posición sol en coordenadas del ángulo acimut (α), y el 
ángulo de altura (γ)

Para poder trabajar con mayor simplicidad y precisión, normalmente, 
se utilizan representaciones en dos dimensiones de la trayectoria solar 
que llamamos las proyecciones solares, las que se distinguen en dos tipos: 
polares y cilíndricas. Las primeras son representaciones de la bóveda 
vista desde arriba, mientras  que las segundas son representaciones 
sobre un plano vertical, como un despliegue cilíndrico.

2  Los de acimut van de 0º (Norte) hasta +/-180º (Sur), 90º (Este) y -90º 
(Oeste).
3  Los ángulos de altura van de 0º (horizonte) a los 90º (cenit)
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Esquema representaciones bidimensionales, polar y cilíndrica, de una bóveda.

2.2 Proyecciones polares

La proyección polar es una vista superior de la bóveda celeste, una 
representación del cielo desde la parte alta y proyectada sobre una 
superfi cie paralela al horizonte.
En los diagramas solares el observador se encuentra en el centro 
de la escena. La bóveda  celeste es presentada con circunferencias 
concéntricas que representan ángulos de alturas α constantes sobre el 
horizonte con un incremento de 10 grados. La circunferencia de radio 
máximo coincide con el horizonte, mientras que el centro coincide 
con el cenit.  Desde de la parte central salen radios que representan 
ángulos acimut γ. 

Construcción ángulo acimutal γ=30º [7] p.33

Esta primera parte del diagrama es lo que podemos defi nir como 
mapa del cielo (Skymap), donde cada punto de la bóveda tiene sus 
coordenadas y pueden ser posicionados según los ángulos acimut y 
altura.
En cuanto a la representación polar de la bóveda se suelen utilizar 
tres tipos: la proyección Ortográfi ca; la proyección Equidistante 
y la proyección Estereográfi ca. Éstas se diferencian entre sí por la 
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representación de las circunferencias de ángulo acimut. 
Después que se ha realizado la proyección polar del cielo se pasa a 
trazar el recorrido solar. El cruce entre circunferencias concéntricas 
y radios permite marcar la posición solar en el diagrama y el cruce 
entre una línea dada y una línea de hora coincide con una pareja 
de valores α y γ . Conocidos los ángulos y conectando la posición 
del sol en cada hora se dibuja la trayectoria solar de algunos días. 
Normalmente se dibujan las líneas solares del 21 de cada mes. Cada 
mes, caracterizado por una declinación media, es representado sobre 
el diagrama por arcos simétricos respecto al eje norte-sur. Estos arcos 
estarán más al norte cuanto más nos acercamos al solsticio de verano 
y más al sur cuanto más nos acercamos al solsticio de invierno. La 
curva del 21 de junio, solsticio de verano, coincidirá con el semi-
arco extremo, caracterizado por ser el más largo y el más al norte 
del diagrama. Mientras el semi-arco del 21 de diciembre será el más 
pequeño y el más al sur.4 Si conectamos las horas de cada línea se 
obtiene una representación de las horas de cada día.

Vista 3D y proyección polar equidistante del recorrido solar en todo el año [7] p 25,35

4  Esto por el hemisferio boreal y será al revés por el hemisferio austral.  

2.3 Proyección Ortográfi ca, Equidistante y Estereográfi ca

La proyección Ortográfi ca, también llamada Esférica u Ortogonal, 
es una vista real a distancia de la bóveda celeste. Siendo una 
representación ortogonal superior de la bóveda en el plano, presenta 
las circunferencias concéntricas de los ángulos de altura α cerca del 
horizonte más ajustadas entre ellas, como si la semiesfera hubiese sido 
aplastada en el plano. Esta vista suele ser acompañada de una vista 
lateral, vista desde el oeste. Este tipo de proyección es la más real 
pero, a causa de la cercanía de las circunferencias de ángulos α más 
bajas (exteriores), crea mayor difi cultad en la lectura de la parte más 
cercana al horizonte.         
Para corregir esta limitación se suelen usar otras proyecciones polares, 
como la Equidistante o la Estereográfi ca, que son abstracciones de 
la Ortográfi ca. Ambas proyecciones permiten apreciar con mayor  
facilidad las primeras y las últimas horas del día en el diagrama.
En el diagrama Equidistante, a diferencia al diagrama Ortogonal, 
viene forzada una equidistancia entre las circunferencias de altura, de 
modo tal, que los elementos de igual distancia en la bóveda mantienen 
su distancia en la proyección. En consecuencia, se obtendrá una mayor 
holgura de los ángulos bajos y una más fácil lectura, en general, de los 
ángulos una vez trazados los diagramas de sombras.
La proyección Estereográfi ca, aun más que la Equidistante, permite 
visualizar las eventuales posiciones solares más bajas, en cuanto, las 
circunferencias concéntricas en la parte más extrema del diagrama 
estereográfi co presentan más espacios entre ellas que las circunferencias 
más cerca del punto central cenital. Esto se obtiene gracias una 
particular construcción que desplaza el centro de vista, tal como se 
puede observar en el esquema. Por esta razón, esta última proyección 
se utiliza con mayor regularidad en latitudes más extremas.
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Esquemas de las diferentes proyecciones polares
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2.4 Proyecciones cilíndricas

Como alternativa a las proyecciones polares se pueden utilizar 
diagramas de proyección cilíndrica del movimiento del sol. Este tipo 
de diagrama da una proyección vertical del recorrido solar.
Para el diagrama cilíndrico se dibuja una reja de líneas horizontales 
y verticales. Las horizontales representan los ángulos de altura α  
con incremento constante de 10 grados, mientras que las verticales 
representan los ángulos de acimut γ con incrementos de 15 grados.
La totalidad del diagrama representa ángulos verticales y horizontales 
de toda la bóveda celeste y permite dibujar la posición del sol en el 
mapa bidimensional plano y, como en el caso de los diagramas polares, 
cada punto con fecha y hora están representados por coordenadas 
cartesianas α y γ. 
De la misma manera que distinguimos las proyecciones ‘superiores’, 
podemos diferenciar tipos de proyecciones cilíndricas. Las más 
comunes son la proyección Ortogonal u Ortográfi ca,  la Equidistante 
y una proyección cilíndrica llamada Diagrama de Waldram. 
La proyección Ortográfi ca, como en el caso de las polares, coincide 
con un despliegue ortogonal de la bóveda celeste vista desde un punto. 
Presenta las líneas de altura extremas más cerca la una de la otra 
cuanto más nos acercamos al extremo cenital. 
La proyección comúnmente usada es la Equidistante, por la facilidad 
de construcción, donde se corrige la diferencia de dilatación entre las 
“líneas de altura”. 
En el Diagrama de Waldram  los ángulos de altura más elevados se 
representan con líneas más distantes unas de otras. La utilización de 
este último está  limitado a temas de iluminación natural.  

2.5 Proyección Gnomónica

Otro tipo de proyección que resulta interesante mencionar, que a 
diferencia de las otras proyecciones no representa la bóveda celeste 
sino el recorrido de las sombras, es la Proyección Gnomónica. Ésta se 
caracteriza por representar el recorrido de las sombras en la superfi cie 
que genera la presencia de un Gnomón y puede ser comparada 
con un reloj solar. Ésta puede utilizarse como modelo a escala para 
imitar situaciones de cualquier latitud al margen del emplazamiento 
en que se utilice. La construcción de la Gnomónica se realiza en 
base a la proyección Ortográfi ca y es necesario que ésta haya sido 
bien construida y es imprescindible acompañar la proyección con la 
indicación de la altura del gnomón con la que ha sido hecha. Esta 
herramienta resulta útil cuando trabajamos con un modelo en escala, 
para tener una idea aproximada de las horas y del día en el cual cae 
la sombra y la manera en que cae la radiación solar directa al edifi cio 
en el mes y hora que escojamos.

2.6 Trayectorias solares y programas informáticos

A partir de los años ’90 son muchos los programas informáticos que se 
han desarrollado y siguen desarrollándose de dibujo de la geometría 
solar. Con las aplicaciones de tecnologías que aprovechan del sol, como 
los paneles solares, el mercado de la informática se ha ido adecuando 
a las necesidades de los proyectistas. Hoy es posible obtener desde 
Internet muchas aplicaciones, generalmente gratuitas, que permiten 
dibujar diagramas solares y sombras de un edifi cio o de un entorno. 
En el desarrollo de esta tesis nos ha parecido importante estudiar 
distintos programas informáticos especializados en acondicionamiento 
ambiental y que creemos interesante mencionar.
El programa que normalmente hemos utilizado para obtener 
diagramas solares es Heliodon. Este programa tiene la característica de 
darnos tres visiones de un espacio arquitectónico, una vista superior, 
una proyección polar, con posibilidad de elegir entre Estereográfi ca, 
Equidistante y Ortográfi ca, y una vista axonométrica. Además, nos 
permite realizar cálculos de incidencia solar y factores de vista.  
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Construcción de diagramas de la trayectoria solar con el plugin SunTools para SketchUp

Existe un plugin para SketchUp, para todos los sistemas operativos, 
que se puede bajar gratuitamente desde Internet, que se llama 
SunTools, que nos da una representación 3D de la bóveda celeste. La 
particularidad de esta herramienta es la posibilidad de ver la posición 
del sol con indicación de horas y meses en las perspectivas. 

De la compañía Autodesk existe un programa específi co para el control 
medio ambiental denominado Ecotect, que ofrece varias herramientas 
de dibujo y es perfectamente compatible con Autocad y 3D Studio 
Max. Éste además de facilitar el estudio solar de un edifi cio, dispone 
de muchos instrumentos útiles para el estudio térmico, luminoso 
y acústico. Pero a causa de sus diferentes funciones puede resultar 
complejo en su utilización. 
Otro programa es el Ener_lux, específi co para estudiantes de Física 
Técnica Ambiental, realizado por el arquitecto Carbonari y 
desarrollado por la Universidad de Arquitectura de Venecia. Permite 
analizar un entorno arquitectónico con proyecciones polares, sea 
desde vistas superiores que laterales, y añade a su interior cálculos de 

incidencia solar con ábacos de radiaciones.  
De todas formas, muchas son las páginas de Internet desde donde es 
posible obtener diagramas solares sin que sea necesario bajar ningún 
programa, por lo que es sufi ciente trabajar en la red, como por 
ejemplo la página www.solaritaly.enea.it que permite realizar tablas y 
diagramas de la posición del sol en el territorio italiano. 
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La cámara y los equipos fotográfi cos

Antes de continuar con nuestra tesis, pensamos que es importante 
conocer los instrumentos con los que nos proponemos trabajar, sobre 
todo, por el hecho que nos enfrentamos a una fotografía científi ca y 
no artística. Por esto dedicamos un pequeño capítulo a la cámara y 
los equipos fotográfi cos, que en el futuro serán nuestras principales 
herramientas de trabajo.
Frente a las cámaras contemporáneas y sofi sticadas, es difícil pensar 
que la cámara en realidad es un instrumento muy simple formado 
principalmente por dos partes: una caja cerrada con una pequeña 
abertura en una extremidad, que permite entrar la luz (cámara oscura 
o cuerpo), y un elemento fotosensible, en la otra extremidad, 
que graba la luz entrante. Luego se puede añadir otro elemento, que 
hace al sistema un poco más complejo: el objetivo. 
Con el paso del tiempo, las cámaras han mejorado mucho y se ha 
llegado a una notable evolución, pasando desde una caja de madera 
con una lámina de plata hasta llegar a las actuales cámaras digitales, 
que a pesar de ser complejas, están formadas principalmente por estas 
tres partes o elementos. 
Podemos encontrar varios tipos de cámaras en el comercio, pero se 
pueden dividir principalmente por su estructura, por el tamaño de las 
películas y por el tipo de superfi cie fotosensible. 
Por su estructura distinguimos cuatro grupos: panorámicas, compactas, 
refl ex de doble objetivo y refl ex  mono objetivo; por el tamaño de la película 
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en tres tipos: gran formato, películas planas normalmente de 9x12; medio 
formato, normalmente 6x6;   y pequeño formato, normalmente de 35 mm 
(incluyendo las perforaciones) o 24x36 (dimensión de la imagen). 
Actualmente podemos distinguir también entre analógicas, si la 
superfi cie fotosensible es una película, y digitales, cuando la superfi cie 
fotosensible es sensor digital (CCD o CMOS).
No existe la cámara perfecta, cada una tiene sus puntos a favor y 
sus puntos débiles, así una puede ser mejor para encuadrar la escena 
o puede dar resultados más nítidos, otra puede ser más versátil y 
práctica, una más económica y otra más cara.
Entre los profesionales, las usadas por versatilidad, precio y resultado 
son las cámaras refl ex mono objetivo de 35mm.   

3.1 El cuerpo de la cámara 

Las cámaras o cuerpos, están compuestas principalmente por tres 
elementos: un visor, el obturador y un exposímetro.

3.1.1 El visor

El visor nos permite ver lo que está encuadrado en la cámara y lo que 
se grabará en la película. Normalmente podemos distinguir en: visor 
simple, visor refl ex y visor refl ex bifocal.
El visor simple o fi jo es típico de las cámaras compactas y es una 
abertura en la cámara que simula el encuadre de ella. Normalmente 
presenta el problema que no estando en el mismo eje del objetivo, la 
escena visualizada no coincide perfectamente con la imagen que se 
obtiene. Este se llama error de paralaje vertical y horizontal, éste se 
nota principalmente en los enfoques de distancia corta. Actualmente 
con las cámaras digitales compactas este error ha sido superado, al 
ser sustituido por una pantalla LCD ubicada en el mismo eje del 
objetivo. 
En el visor refl ex  la imagen que se ve pasa por el mismo objetivo 
de la cámara, que se refl eja en un espejo puesto a 45º entre la lente y 
la película, pasando por un prisma corrector para llegar hasta el ojo. 
El espejo al momento del saque se levanta y permite a la luz llegar a 

la superfi cie fotosensible sin encontrar obstáculos.1

Se usan visores bifocales en cámaras que tienen dos lentes iguales, 
una que sirve para el visor, donde la imagen se refl eja también en un 
espejo puesto a 45º , y otra lente para la foto. En estos tipos de cámaras 
no es necesario que el espejo se levante al momento del saque.

3.1.2 El obturador 

El obturador de la cámara es una unidad mecánica, compuesto por 
láminas opacas, normalmente colocada entre el objetivo y la película.2 
Este raciona el tiempo de exposición de la película a la luz, abriéndose 
durante el tiempo seleccionado para que la luz pueda grabarse en la 
lámina fotosensible. 
Distinguimos dos tipos de obturadores: a cortina, donde dos láminas se 
abren y se cierran horizontalmente; y central, donde una “fl or” o “iris” 
se abre desde el centro hacia el exterior. 
El obturador es uno de los elementos más importantes de la cámara y 
fundamental para nuestro trabajo en cuanto es, con el diafragma de 
la lente, uno de los dispositivos que controla la cantidad de luz que 
llega al sensor.
Hay que pensar en el obturador como una puerta o una cortina de 
una ventana, cuanto más tiempo la cortina esté abierta más luz llegará 
a la habitación.
El obturador de la cámara puede ser mecánico o electrónico. 
Actualmente las cámaras modernas están dotadas de obturador 
electrónico alimentado por una batería.
Las velocidades normales de obturación van de 1 a 1/500 segundos, 
mientras que las cámaras digitales tienen una “selección” de tiempos 
más amplia, desde 5s hasta 1/8000. La mayoría de cámaras manuales 
tienen unos tiempos llamados “B” y “T”. En el primer caso, el 
obturador se abre cuando se acciona el disparador y seguirá abierto 
en tanto se siga presionando, mientras que en el segundo caso, se 

1  En unas cámaras, principalmente de grande o medio formato, la imagen 
se ve al revés, cámaras a pozo. 
2  En algunas cámaras, normalmente de grande o medio formato, el 
obturador se encuentra en medio del objetivo, junto a la abertura.
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abrirá con un golpe al disparador y se cerrará accionando otra vez el 
botón de disparo.
Con tiempos de exposición más largos de 1/60s3, las fotos pueden 
salir movidas, ya que hasta nuestra respiración puede infl uir en el 
movimiento de la cámara.   

3.1.3 El exposímetro

El exposímetro o fotómetro, como dice la misma palabra “expo” o “foto” 
más “metro”, es un instrumento que nos ayuda en la medición de 
la luz o de la exposición. Hablamos de este último en este capítulo, 
en cuanto esta herramienta está presente en casi todas las cámaras, 
pero existen exposímetros externos o manuales, muy utilizados por 
los profesionales de la fotografía.
Los fotómetros externos a las cámaras, son instrumentos que 
nos permiten medir la luz en diferentes modos. A diferencia de 
los internos, nos permiten también medir la luz incidente total en 
el sujeto que queremos fotografi ar, acercando el aparato al sujeto y 
apuntándolo hacia la cámara. Sin embargo, resultan caros y poco 
prácticos al momento de sacar fotografías rápidas.

Los exposímetros internos, presentes en la mayoría de cámaras, 
sea de forma automática, sea de forma manual o a prioridades4, nos 
permiten solamente la medición de la luz refl ejada por el sujeto hacia 
la cámara.     
Existen principalmente cuatro tipos de exposímetros, dependiendo de 
la zona de la escena donde se realiza la medición: de lectura media o 
integral, que hace una medición de la mayoría de la imagen; centrado, 

3  En realidad este depende también del tipo de focal que estamos 
utilizando, con teleobjetivo podemos tener una velocidad mínima de 1/250 o 
1/500
4  Prioridad de tiempo o de abertura. En el primer caso el fotógrafo fi ja el 
tiempo de saque y la cámara automáticamente elige la abertura del diafragma, 
mientras que en el segundo caso el fotógrafo elegirá el tipo de abertura y la 
cámara en consecuencia el tiempo. 

que realiza dos lecturas de la luz, una de la parte central y otra de 
la parte periférica de la escena; spot, que realiza la medición en una 
pequeña parte de la imagen; lectura integrada, comparada o matrix, que 
es capaz de cubrir varias zonas de la imagen y hacer una media, por 
un algoritmo, eligiendo el nivel de exposición más oportuno. 
No podemos decir que exista un tipo mejor o peor de exposímetro, 
sino que depende mucho del tipo de foto que se quiere sacar. Los 
exposímetros de lectura integradas son los más fi ables y normalmente 
no necesitan correcciones técnicas  por el fotógrafo.

Exposímetro profesional Sekonic - SE L398A - Studio Deluxe III - L398A precio 153€. http://www.
tuttofoto.com/Catalogo.abl?cmd=md&id_articolo=9859429
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3.2 Los objetivos 

El objetivo es un dispositivo óptico, aplicado a la cámara, que 
permite a la luz pasar e impresionar  la película o el sensor de nuestra 
fotocámara. 
Los objetivos “pioneros” estaban compuestos por una sola lente. Con el 
pasar del tiempo y la evolución de la técnica, para evitar aberraciones, 
distorsiones ópticas y cromáticas, éstos se han vuelto más complejos, 
multiplicando el número de lentes hasta 17-18 “vidrios”.
Existen varios tipos de objetivos por marcas y modelos, pero se pueden 
dividir, sustancialmente, en cuatro grandes grupos dependiendo de la 
distancia focal. Ésta es la distancia que separa la película o plano focal del 
centro del objetivo5, siendo regulado con el infi nito. La distancia focal, 
expresada con una cifra en milímetros, está grabada normalmente en 
la parte exterior del objetivo junto a la abertura máxima.
Los cuatro grandes grupos de lentes son: fi sheye6, objetivos de ángulo 
de visión extrema con distancia focal que varía entre 8 y 16 mm; 
gran angular, objetivos que pueden tener un notable ángulo de visión, 
cuya longitud focal varía entre 18 y 35 mm; estándar o normal, siendo 
su distancia focal de 45 -50 -55 mm; teleobjetivo, con distancia focal a 
partir de 80 mm.
Cambiar distancia focal quiere decir, alterar el ángulo de visión y 
cambiar la distancia de encuadramiento de la escena disimulando lo 
cerca o lo lejos que pueda estar un sujeto, y reducir o exagerar la 
perspectiva fotográfi ca. Para entenderlo mejor, podemos pensar que 
los objetivos estándar o normales, que tienen un ángulo visual alrededor 
de los 45º, reproducen los tamaños de las cosas a distinta distancia 
de modo equiparable a la visión de nuestros ojos. Pues, es fácil de 
entender, como objetivos con distancia focal más pequeña de la 
“normal” tendrán ángulo de visión mayor a lo que puede llegar el ojo 
humano, mientras los que tendrán distancia focal  mayor, alcanzarán 
un ángulo de visión más estrecho y darán una visión más grande de 

5  Este coincide con el centro en que se situaría el centro de un objetivo de 
lente simple de esta misma distancia focal. 
6  Hablaremos más en detalle de estos tipo de objetivos en el próximo 
capítulo

las cosas. Distancias cortas abarcan campos muy anchos mientras 
enfoques largos, un campo más restringido.
Hay objetivos de distancia focal fi ja y zooms (distancia focal variable)7. 
Los primeros son, normalmente, de mejor calidad y permiten 
imágenes más luminosas y nítidas, mientras que los segundos son más 
prácticos, en cuanto permiten obtener campos de vista diferentes. 

Ángulo de visión y distancia focal; http://www.robertosartori.net/corsofoto.htm

7  Estos pueden variar desde granangular/ granangula, grananguar/ 
normal, normal/tele, tele/tele…



30

3.2.1 La abertura

En el interior de los objetivos hay un dispositivo, formado por una 
serie de láminas metálicas negras superpuestas (normalmente de 5 a 
9), llamado diafragma. Éste es una de las herramientas más útiles para 
el fotógrafo, ya que permite el control de luz que entra en la cámara a 
través de un orifi cio o abertura.  Junto al tiempo de saque, el diafragma 
permite regular la exposición de una foto, cambiando el tamaño de 
la abertura. La extensión del diafragma puede llegar a coincidir con 
el diámetro del objetivo, lo que se dice totalmente “abierto”, mientras 
que puede llegar a tener un diámetro minúsculo en el centro, lo que 
se defi ne totalmente “cerrado”. Un diafragma abierto o cerrado se 
muestra por una escala de números llamados números f, lo cual no 
se refi ere al diámetro del agujero dejado por las láminas, sino a la 
fracción entre la longitud focal y el diámetro de abertura. Esto quiere 
decir, que el valor es inversamente proporcional a la dimensión del 
orifi cio, a valores más bajos coinciden con más luz que entra y a la 
inversa. Cada valor de la escala de abertura o de cierre del diafragma, 

Ejemplo de diafragma más abierto y más cerrado.

signifi ca duplicar o dividir la cantidad de luz que llega a la superfi cie 
fotosensible. Es importante recordar que, siendo el valor f   relacionado 
a la distancia focal de las lentes, a diferentes objetivos, iguales valores 
de abertura no coinciden con igual diámetro. 
Cada objetivo en su exterior lleva grabado, junto a la distancia focal, 
un valor que coincide con la abertura máxima. Ésta es una abertura 
relativa, igual a la longitud del objetivo dividida por el diámetro de la 
lente frontal. 

 
La abertura no infl uye únicamente en la capacidad de aclarar u 
oscurecer la imagen sino también en la que se llama profundidad de 
campo8, pues tiene que ver con la nitidez de la foto. A abertura más 
pequeña coincide mayor profundidad de campo, mientras que a 
menor abertura corresponde mayor profundidad.

8  La profundidad de campo es la distancia comprendida entre el punto 
más próximo y el más lejano del sujeto que está siendo enfocado, cuyos detalles 
pueden ser reproducidos nítidamente ajustando al enfoque del objetivo. [2] p.47
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3.3 La película y el sensor de la cámara digital

Las superfi cies fotosensibles son fundamentales en la técnica 
fotográfi ca en cuanto son los instrumentos que nos permiten fi jar la 
imagen en el tiempo9. Varios han sido los materiales que, desde el 1827 
cuando Joseph Niepce realiza la primiera foto, han evolucionado y se 
han probado, pasando desde láminas de peltre o de plata hasta los 
contemporáneos sensores. 
Como hemos dicho anteriormente describiendo los diferentes tipo 
de cámaras fotográfi cas, hay diferencia entre las varias superfi cies 
fotosensibles por su formato (pequeña, media y grande), por sus 
dimensiones ( alargada, cuadrada, rectangular, ect..) o por tipo 
(negativa o diapositiva), por el color (blanco y negro, color), por el 
embalaje (plana, cartucho, disco,…), de sensor (CCD o CMOS10) y 
por su sensibilidad (alta, baja, ect…).
En este capítulo nos ocuparemos de las películas, o de los sensores en 
el caso de la fotografía digital, únicamente desde el punto de vista de la 
sensibilidad a luz, en cuanto no queremos transformar esta tesina en 
un manual de fotografía pero si consideramos fundamental describir 
unos conceptos básicos que nos servirán para nuestro análisis.   

3.3.1 La sensibilidad a la luz

La sensibilidad de una película va acompañada de una cifra que 
indica la rapidez de emulsión que normalmente llamamos valor ISO 
(International Standard Organization). Este es un valor que coincide 
con la sensibilidad de los carretes a la luz y está señalizado en la caja 

9  Ya en el 400 a.C. Aristóteles había descrito las características de la 
cámara oscura; Leonardo Da Vinci, luego perfeccionó esta herramienta y con 
el Renacimiento el uso de éste fue implementado y muy utilizado en pintura. 
Pero el problema era poder grabar la imagen luminosa producida de modo que 
permaneciera en el tiempo.  
10  En los sensores CCD, la conversión desde la luz al dato digital, hecha 
por los fotodiodos, es realizada en el exterior del sensor, mientras que en un 
sensor CMOS, la trasformación se realiza internamente, sin pasar por dispositivos 
externos. Actualmente los CCD siguen siendo más fi ables. 

con dos cifras, por ejemplo, ISO 100/21º, que derivan de dos escalas 
de velocidad. La primera que se usaba en los Estados Unidos, ASA, y 
la segunda, acompañada del símbolo de grados, de la escala alemana, 
DIN. 
La escala ISO, sigue siendo utilizada en el dispositivo digital para 
defi nir la sensibilidad del sensor en un momento dado. Los valores 
comunes son 25, 100, 200, 400, 800 y 1600, cuando más alta sea la 
cifra, la película o el sensor necesitará menos luz y será más rápida, y 
cuando más pequeña sea la cifra, más lenta será la película y necesitará 
más luz. Una película de 50 ISO requiere el doble de la luz que una 
de 100 ISO. 
Para sacar una foto de día, normalmente, usamos una sensibilidad 
de 100 ISO, mientras que para sacar fotos nocturnas o en un interior 
oscuro usamos sensibilidades (o velocidad) más altas, como un 1600 
ISO.

Subiendo en la escala de los ISO aumenta la sensibilidad de los 
elementos fotosensibles, pues la posibilidad de sacar fotos con 
condiciones de luz más “difíciles”, con tiempos de exposición más 
bajos, pero al mismo tiempo, las imagen tendrán problemas de ruido 
o granos. 
Se defi ne ruido o grano de una foto, la presencia de picaduras 
monocromáticas (luminance noise) o manchas coloradas (chroma 
noise) en las áreas más uniformes o más oscuras de la imagen.
Este problema se presenta, aumentando la sensibilidad de las 
películas, por el hecho que, técnicamente, una película más rápida 
se obtiene aumentando el tamaño de los haluros de plata y como 
consecuencia, aumentando el volumen del grano. Este inconveniente 
sigue permaneciendo en la moderna fotografía digital debido a varios 
problemas, como la necesidad de amplifi car las señales débiles, sea por 
el hecho que un único fotodiodo11 afectado por la misma cantidad de 
luz en momentos distintos genera señales de intensidad diferentes.[6] 

11  El fotodiodo es un particular componente electrónico que funciona 
como sensor óptico capaz de reconocer una determinada longitud de onda y 
trasformarla en una señal eléctrica.
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Actualmente, el problema del ruido ha sido notablemente corregido 
y existen cámaras profesionales que casi no tienen este inconveniente 
gracias a sensores más complejos. 

3.4 Medición de la luz, exposición e índices de 
iluminación

Se puede describir la exposición como la suma de tiempo/abertura/
velocidad de la película, cuya relación entre estos tres valores se llama 
reciprocidad. A partir de las mismas condiciones de luz, se obtiene el 
mismo resultado12 bajando, por reciprocidad, un valor y subiendo otro. 
Muchas veces se usa el término exposición para indicar la cantidad 
total de luz que llega en la película en un período de tiempo.
La exposición se mide en EV, Exposure Value, y los índices van de -9 a 
+22. El valor 0 nos indica una exposición correcta, mientras que los 
valores negativos se refi eren a bajaexposición, pues saldrán imágenes 
más oscuras, y los valores positivos indican una sobreexposición, pues 
una excesiva exposición a luz de un material fotográfi co. En la medida 
que los valores se alejan de cero, las imágenes que obtendremos serán 
quemadas u oscuras.  
La exposición se mide a través del exposímetro, regulando la velocidad 
de la película o del sensor, y modifi cando la pareja tiempo/diafragma 
según los valores de reciprocidad.

 

12  La reciprocidad nos da la misma exposición pero no el mismo resultado 
fotográfi co. Recodamos que moviendo el diafragma nos cambia la profundidad 
de campo, aumentando el tiempo la imagen puede salir movida y aumentando la 
sensibilidad corremos el riesgo de obtener foto con ruido.

[1]. Hedgece John,1992, Manual de Técnica Fotográfi ca, Tursan, Madrid
[2]. Langford Michael, 1991, Fotografía Básica, Omega, Barcelona
[3]. Pradera Alejandro, 2004, El libro de la fotografía, Alianza Editorial, Madrid
[4]. Zanner Italo, 1993, Storia e Tecnica della fotografi a, Laterza, Bari
[5]. De Vomécourt A., Consejos y trucos de profesionales, Editions VM
[6]. http://www.3megapixel.it/tips-rumore.html
[7]. http://www.robertosartori.net/corsofoto.htm
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Objetivo Fish-eye (ojo de pez)

Los “ojo de pez”, son unos especiales objetivos fotográfi cos con  ángulo 
de visión extremo. La mayoría de estos objetivos permiten sacar fotos 
con un campo escénico de 180º, pero dependiendo del tipo y del 
productor, el ángulo de visión puede variar entre 160º y 220º1.
Con el paso del tiempo, han sido construidos prototipos que alcanzan 
una vista de hasta de 270º, llegando a dar una visión espectacular, 
alcanzando a representar incluso lo que hay detrás del fotógrafo2.  

1  En el año 1969 Nikkor produjo un objetivo comercializado pero con 
escaso suceso por su especialización. De 430 g de peso, Nikkor 6,3mm f/5,6 con 
un ángulo de visión de 220°; en 1977 Nikon realizó, por una expedición en el 
Antártico, un objetivo que alcanza un ángulo de visión de 220°, un 6mm f/2.8s. 
Actualmente este objetivo esta fuera de producción a causa de su peso y tamaño 
(5,2 kg y un diámetro 236 mm) [1]. Hoy en día, Sunex produce un ojo de pez que 
obtiene imágenes con ángulo de 185°. 
2  Ya en 1968, el doctor Masaki Isshiki, experto de la óptica de la casa 
japonesa Nikkor, había realizado dos prototipos fi sheye-Nikkor 5,4mm f/5,6 con 
ángulo de visión de 270°, capaces de obtener imágenes detrás del fotógrafo.[5]

4.1 Pequeña historia del fi sheye
El primer objetivo fi sheye fue realizado en 1921, cuando el doctor 
Roben Hill desarrolló una primera lente ultra-angular para estudiar la 
formación de las nubes, construida por la fi rma Beck de Londres, y 
llamada “whole-sky-lens” (lente de cielo entero) por su capacidad de 
dar una visión total del cielo en una única imagen. 
En los años ’30 la casa Zeiss, cree en las posibilidades de estas lentes y 
produce ciertos prototipos, desarrollando y estudiando el sistema óptico 
ultra-angular; pero es con los años ’60 que la Nikkor, casa japonesa que 
produce ópticas para Nikon, que comienza el verdadero desarrollo 
de estos objetivos visualizándoles un futuro y una comercialización, 
reconociéndoles una posible aplicación en el campo de la fotografía 
tradicional y no solamente en el campo científi co. De todas formas, 
las primeras lentes continuaron produciéndose para un grupo de 
usuarios muy restringido, muchas se quedaron como prototipos o 
fueron construidas por encargo especial para el Ministerio Japonés de 
Defensa y para agencias metereológicas. 
Es entre los años 1960 y 1961 que fueron producidas y comercializadas 
las primeras cámaras compactas que usan este especial objetivo con el 
nombre de “Fisheye cámara”, a partir del modelo de la lente Fisheye-
Nikkor 16,3mm f/8 realizada en el año 1948 y ya comercializada en 
1957. [5] 
Actualmente las fotos sacadas con objetivo ultra-angular son muy 
conocidas y valoradas por fotógrafos y profesionales de la fotografía. 
Una de las aplicaciones más frecuentes son las imágenes panorámicas, 
alcanzando así, un mayor ángulo horizontal de lo que se podría lograr 
con normales objetivos rectilíneos. De todos modos, las lentes fi sheye 
tienen su apreciación por el particular efecto que dan a las fotos y 
para proponer la curvatura de la Tierra.
Otras aplicaciones se encuentran principalmente en el campo 
científi co, en biología, agricultura y ciencia forestal, por análisis del 
dosel y de la canopea.
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Así también, se utiliza la visión a ojo de pez en los simuladores de 
vuelo y en los planetarios, por las proyecciones de la bóveda celeste.  
Es muy frecuente el uso de la imagen fi sheye en la gráfi ca 3d, para 
construcciones de escenas más reales y con ambientes panorámicos. 
[6]

El término “fi sh-eye” tiene su origen en un estudio sobre la refracción 
de los rayos de luz en la superfi cie de un lago, en el cual en el año 1911 
Robert W. Word en su libro, Physical Optics, habla de  la capacidad 
óptica de los peces de ver la totalidad de una semiesfera [2]. 

Nikon “Fisheye camara” comercializada el 1960 con funda y tapón; www.luciolepri.it/lc2/marcocavina/articoli_fotografi ci/Nikkor_fi sheye_story
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4.2 Principales características de los objetivo ultra-
angulares

Son dos las principales características que se encuentran en todas las 
lentes de ojo de pez: la primera es la capacidad de alcanzar ángulos 
de visión muy grandes, y la segunda el particular efecto deformado.
Una imagen obtenida con objetivo ultra-angular presenta una fuerte 
distorsión a “barril”, lo que signifi ca, que se deforma lo que en la 
realidad aparece como una línea recta en una curva. La imagen se 
presenta más deformada cuanto más nos alejamos del centro y nos 
acercamos al borde de la foto.

Deformación de las líneas rectas en una foto fi sheye; http://wiki.panotools.org/Fisheye_Projection

Actualmente existen varios correctores  de imagen: hay lentes que 
intentan corregir la distorsión para obtener imágenes rectilíneas, más 
parecidas a la visión de nuestro ojo. Pero todavía no existe una lente 
con ángulo de captura  superior a 100° horizontales que no deforme las 
fotos. De todos modos, las fotos sacadas con una lente fi sheye pueden 
ser transformadas por medio de diferentes softwares apropiados, ya 
sea de foto retoque o de elaboración de imágenes, como Photoshop. 
La corrección digital tiene su contrapartida, y es que resulta una 
pérdida de calidad y detalle a los extremos de la imagen. [3]

 Conversión rectilínea de una foto fi sheye 35mm full frame  fi sheye de 911 Ground Zero. Nueva York; http://photo.net/learn/fi sheye



37

La mayoría de los objetivos fi sheye, sobre todo los que están realizados 
para cámaras refl ex, son ópticas retrofocus3 (realizadas por primera 
vez en los años ’60). Estos objetivos están formados como un “tele-
objetivo invertido”, con unas lentes anteriores divergentes y unas 
posteriores más pequeñas convergentes. Esta es una característica 
frecuente, pero no todos los objetivos ojos de pez tienen este tipo de 
óptica. Por ejemplo, los primeros objetivos, como el fi sheye-Nikkor 8mm 
f/8, no estaban dotados de tecnología retrofocus, eran muy compactos 
pero, a causa de su profundidad, obligaban a levantar el espejo de la 
cámara y a usar una mirilla exterior. Muchas cámaras compactas no 
son retrofocus.  

Esquema de refracción de la luz de un Objetivo Fisheye Retrofocus de 220º de angulo de vista
http://www.pierretoscani.com/echo_fi sheyes.html

3  Retrofocus: cuando la distancia focal es menor que la distancia entre 
el punto nodal principal y el plano focal. Esto permite que el objetivo no se 
introduzca demasiado adentro de la cámara réfl ex, evitando problemas en libre 
movimiento del espejo, cosa que pasaba con las primeras lentes fi sheye.

4.3 Diferentes tipos de lentes fi sheye

Existen diferentes tipos de lente fi sheye, sea por la visión que éstas 
ofrecen sea por los diferentes tipos de distorsión.

4.3.1 Lentes fi sheye: diferentes campos de visión 

Hay dos tipos de lentes teniendo en consideración el campo de visión: 
circular y fullframe.
Los objetivos fi sheye circulares fueron los primeros en ser 
fabricados, tienen un ángulo de visión de 180° en las tres direcciones 
de la foto, por tanto en diagonal, vertical y horizontal. En el normal 
soporte fotográfi co aparece un círculo negro inscripto en el marco de 
la fotografía. Siempre los ángulos y la parte extrema de cada imagen 
aparece negra. En las cámaras tradicionales de 35 mm el círculo se 
puede adaptar al lado más corto o puede ser recortado en los extremos 
de la vertical del campo de visión. Un tamaño cuadrado, como un 
8mm, sería más apto  a este tipo de fotografía.4 Estos tipos de lentes 
son las más usadas para estudios científi cos.5

 

4  Zeiss F-Distagon 24mm f3.5-5.6; Kowa 19mm f4.5; [4]
5  Peleng 8 mm f/3.5; Canon FD 7.5 mm f/5.6 (fuera producción); Nikkor 
8mm f/2.8 (fuera producción); Nikkor 6mm f/2.8 lens (fuera producción); Sigma 
8 mm f/3.5 EX DG (fuera producción); Sigma 8 mm f/4 EX DG; Sigma 4.5 mm 
f/2.8 EX DC Circular Fisheye HSM ; Sunex 185 deg SuperFisheye 5.6mm f/5.6 
for DSLRs; Vemar 12mm f/5.6 Fish-Eye / Ultra-Wideangle—circular image on 
full-frame 135 cameras [4]

Los objetivo fi sheye fullframe son lentes que se han ido fabricando 
como consecuencia de  la difusión de las fotografías a ojo de pez y al 
aumentar la popularidad de éstas. Son lentes que obtienen fotogramas 
que se adaptan al formato de la 35 mm, ocupando por entero el 
espacio de la foto. Con este tipo de lente se realizan imágenes con el 
ángulo de 180° solamente en diagonal, reduciéndolo en horizontal 
a 147° y en vertical a 94°. Con estos objetivos no encontramos en la 
fotografía los tradicionales marcos negros que hay en las fotografías 
sacadas con un fi sheye circular. Actualmente estos tipos de objetivos 
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Imagen tomada con lente fi sheye circular del centro astronómico Joint: http://www.jach.hawaii.edu/
UKIRT/instruments/wfcam/photos 

Imagen sacada con lente fi sheye fullframe de Nueva York: http://www.ronsaari.com/stockImages/nyc/
FlatironAndMetlifeBuildingFisheye.php

son los más usados por los profesionales de fotografía. Se fabrican 
muchas lentes fullframe, sea para cámaras 35 mm6, sea para cámaras 
de medio formato7.

Esquema de diferentes adapatación al fotograma en relación al campo de visión

6  AF DX Fisheye-Nikkor 10.5mm f/2.8G ED; MC Zenitar 16mm f/2.8; 
Sigma 15 mm f/2.8 EX DG Diagonal Fisheye; Sigma 10 mm f/2.8 EX DC 
Fisheye HSM; Zoom Tokina 10-17mm f/3.5-4.5 fi sheye lens for APS-C sensors
Canon EF 15mm f/2.8; Minolta/Sony AF 16mm f/2.8 Fisheye; Olympus Zuiko 
Digital ED 8mm f/3.5 Fisheye; Pentax DA 10-17mm f/3.5-4.5 ED; Samyang 
Optics 8 mm f/3.5 Fisheye CS (stereographic projection) [4]

7  Zeiss F-Distagon 30mm CF f/3.5; Zeiss F-Distagon 30mm CFI f/3.5; 
Zeiss F-Distagon 30mm IHI f/3.5; Kiev Arsat 30mm f/4.0; Mamiya 24mm 
f/4.0; Mamiya 37mm f/4.5 fi sheye C; Mamiya 37mm f/4.5 fi sheye Z; Pentax 
Super Multi Coated Fish-eye-takumar 35mm f/4.5; SMC Pentax 67 fi sh-eye 1:4.5 
35mm; Rollei Zeiss F-Distagon 30mm f/3.5; Rollei Zeiss PQ F-Distagon f/3.5 
30mm; Zenza Bionica PE 30mm f/3.5 fi sheye; Zenza Bionica PS 35mm f/3.5 
fi sheye; Zodiak 180 fi sheye;[4]
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4.3.2 Lentes fi sheye: diferente proyección 

Otra diferencia que se puede encontrar entre los varios objetivos es la 
proyección que se obtiene de una realidad tridimensional (espacio) y la 
imagen bidimensional (foto).8 Cada óptica, de diferentes productores, 
con diferentes curvaturas y distancia focal de las lentes, puede dar 
imágenes con importantes diferencias. Es fundamental conocer el 
tipo de lente que se está utilizando y los diferentes modos que ésta 
representa la realidad en el papel, sobre todo si estas imágenes son 
utilizadas para estudios científi cos. 
Las proyecciones más comunes son de 4 tipos: ortográfi ca, 
estereográfi ca, equisólida y equidistante. Actualmente se fabrican 
específi cos objetivos con diferente distorsión, por encargos especiales 
y para diferentes fi nes. 

Hay lentes ortográfi cas que producen imágenes donde los bordes 
de la foto son muy reducidos, aún cuando se tenga un ángulo de 
visión de 180°. Las imágenes aparecen como una semiesfera vista 
desde arriba y aplastada en el plano.9 Estos tipos de objetivos no son 
muy comunes y son poco comercializados a causa de la pérdida de 
detalle en la parte periférica de las imágenes, pero son muy aptos para 
estudios científi cos.  
Otros objetivos fi sheye, poco comunes y específi cos, son las lentes 
estereográfi cas. Éstas son muy aptas a los fotógrafos porque no 
comprimen mucho la parte perimetral de la foto, son muy útiles 
con fi nes de estudios solares, por la información que éstos pueden 
dar de las partes más anguladas de las fotos. Una particularidad 
muy importante, es el hecho que éstos conservan los ángulos y no 
la distancia. Esta característica es la principal causa por la que las 
imágenes estereográfi cas se utilizan para varios fi nes científi cos. No 
obstante sus buenas propiedades, este tipo de lente es muy poco 
producido, pocas casas realizan estos tipo de objetivos, porque son de 
difícil fabricación sus convergencias. 

8  ver capítulo 2
9  Este es el tipo de lente que usamos en la parte experimental de la tesis

Foto fi sheye ortográfi ca; http://imaging.nikon.com/products/imaging/technology/nikkor/n06_e.htm

Foto fi sheye estereográfi ca; http://imaging.nikon.com/products/imaging/technology/nikkor/n06_e.
htm
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Un tipo de ojo de pez muy  habitual es la lente con ángulo de 
proyección equisólido. Este tipo de lente obtiene proyecciones 
similares a las que se obtienen con un globoscopio, como las imágenes 
que se pueden lograr con el refl ejo de un espejo esférico. Asimismo, 
como otras lentes, aplasta mucho la parte periférica del campo de 
visión.
Una lente muy parecida a la equisólida es el fi sheye con proyección 

equidistante. Este tipo de objetivo es muy interesante por su 
capacidad de mantener en la proyección la misma proporción en la 
distancia. Elementos de igual dimensión en la realidad, posicionados 
a igual distancia del punto de saque, quedarán de igual dimensión en 
la foto. Si un objeto dado se encuentra en la realidad a 45º desde el 
eje de la foto, en la imagen se encontrará a media distancia entre el 
centro de la foto y el borde. Estos objetivos son idóneos en el análisis 

proyección equidistante proyección ortográfica proyección esteriográfica
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R

θ

de la luz indirecta para obtener factores de cielo. [7]
Las fotos equidistantes se pueden comparar con los valores de un 
escáner del cielo, realizando oportunas correcciones.

Hay en mercado otros tipos de ojo de pez con distorsiones diferentes, 
pero estos normalmente se obtienen por encargos especiales y hay 
empresas que producen lentes con ángulo de proyección y campo de 
visión por específi cos pedidos10. [8]

Actualmente se están desarrollando varios softwares y algoritmos que 
permiten transformar una foto con un tipo de proyección en otra. 
Uno de lo más conocido es “PanoTools” o “Panorama Tools”, pero 
existen además varios plugin para software de foto retoque como el 
Flaming Pear para Photoshop.    

En relación al tipo de proyección que tenemos se puede obtener la 
posición de un punto R en el espacio real a partir de una imagen. 
Existen para cada proyección unos simples algoritmos que calculan 
en relación al punto R, la distancia focal f y el ángulo θ entre el eje de 
la foto y el punto.

Proyección ortográfi ca: R = f  * sin (θ) 
Proyección estereográfi ca: R = 2 f  * tan (θ / 2)
Proyección equidistante: R =f  * θ
Proyección equisólida: R = 2 f  * sin (θ / 2) 

Actualmente la investigación sobre este campo esta avanzando 
rápidamente, gracias al desarrollo de programas para corrección de 
la distorsión a barril y el uso de imagen de gran ángulo en la realidad 
virtual y en los videojuegos.
 

  

10  La fi rma Sunex produce especiales fi sheye para casi cualquier uso. Esquema de relación entre punto R de una foto y angulo θ

Comparación entre imagen obetenica con un Sky scaner y una foto fi sheye equisolid
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4.5 Fisheye converter

Son dispositivos “no focales” que varían la longitud de la óptica sobre 
la cual están montados. Normalmente estas lentes se acoplan como 
si fuesen unos fi ltros, es decir, enroscándolos y añadiéndolos a otras 
lentes11. La calidad de las imágenes obtenidas no es muy buena, pero 
los convertidores son una forma económica de obtener fotos con efectos 
fi sheye y pueden ser una alternativa de bajo costo a los caros objetivos 
ojo de pez. 
Estos están en el mercado desde hace mucho tiempo y principalmente 
eran comercializados en los años ’70, cuando el coste de las cámaras 
fotográfi cas era muy alto. En nuestros días, han vuelto a ser frecuentes 
en el comercio, cuando con la introducción de las fotocámaras 
digitales muchos afi cionados se han acercado a la fotografía. En los 
últimos años, con la bajada de los precios y la mayor competencia en 
el mercado, ha disminuido la venta de estos adaptadores coincidiendo 

11  Kenko 0.19x; Nikon FC-E8; Nikon FC-E9; Olympus F-con02; raynox 
180; raynox 185; Soligor 0.19X; [4]

4.4 Lentes fi sheye para cámaras analógicas tradicionales y 
cámaras digitales

Lo que puede cambiar entre una tradicional cámara analógica y una 
cámara digital es principalmente la distancia focal y el campo de 
visión. El campo de visión depende de la distancia focal de la lente y 
el tamaño de la película. En las cámaras analógicas con película 35 
mm la distancia focal tradicional por un objetivo fi sheye circular es de 
8-10 mm y 15-16mm por un fullframe. 
En la fotografía digital ya no encontramos las películas si no los 
sensores, que normalmente tienen un tamaño más pequeño del 
tradicional fotograma de 35 mm.
Para una cámara digital el tipo de campo de visión puede variar en 
relación al tipo de sensor de la cámara, se puede llegar hasta un 1-2 
mm. Este tipo de lentes se llaman “miniaturas” y se usan normalmente 
en cámaras de seguridad. 
Las fotos cámaras digitales están dotadas de multiplicadores que 
normalmente aparecen en las fi chas técnicas de cada producto con 
un valor seguido de una “x”. En la práctica es el valor por el cual hay 
que multiplicar la distancia focal de un objetivo puesto en una cámara 
con sensor  para obtener el mismo campo de visión en una cámara 
con película 35 mm. Por ejemplo  un objetivo 100 mm montado sobre 
una cámara con multiplicador “1.6x” tiene el mismo ángulo de visión 
de un 160 mm en una cámara 35 mm. 
 

http://www.northlight-images.co.uk/Canon_new_lenses.html 
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con la bajada de los precios de los objetivos fi sheye, en cuanto se han 
acercado los precios, con lo que resultan preferidas las ópticas que 
ofrecen mejor calidad.
Estos tipos de convertidores no son aptos para fotografías con fi nes 
científi cos, sino más bien, para los amantes del efecto a barril y 
para fotos panorámicas, porque con éstos se obtienen imágenes que 
no dan la geometría de las proyecciones clásicas y controladas. Es 
fácil entender cómo la distorsión fi sheye del adaptador se suma a la 
deformación, también si mínima, del objetivo de base.      

Varios ejemplos de convertidores fi sheye; http://panopticus.altervista.org/fi shlist/adapters.htm

4.6 El “Globoescopio” o espejo esférico

Hay otro sistema para obtener imágenes de 180º o más: el globo-
escopio o espejo esférico. Este sistema consiste en fotografi ar una 
esfera brillante de alta refracción. Es una técnica muy simple, práctica 
y económica. Las propiedades de un espejo esférico son conocidas 
desde hace mucho tiempo, es muy común ver estos tipos de espejos en 

las esquinas de las calles, permitiendo a los conductores ver los coches 
detrás de una curva. 
Hoy este método continúa desarrollándose y perfeccionando, son 
muchas las investigaciones sobre el refl ejo de la imagen en un cuerpo 
curvo. Con este sistema se pueden obtener diferentes proyecciones del 
espacio, estos dependen de la forma de la esfera y del tipo de cámara 
utilizada.12 Son bastantes conocidos los efectos de la refl exión que las 
diferentes formas y curvaturas pueden dar. [11] Para los afi cionados 
a la fotografía, y sobre todo de fotografía panorámica, hay varios 
productos en el comercio que utilizan este método.  
La del espejo esférico es una técnica que se puede utilizar para 
obtener, con programas de gráfi cas 3D, renders con efecto fi sheye 
sin que sea necesario añadir plugin a los software, será sufi ciente 
crear una esfera brillante y orientar la cámara virtual sobre la 

12  Es importante que la cámara utilizada tenga un objetivo sin distorsiones 
añadidas, con proyección rectilínea porque este podría llevar a una suma de 
efectos difícil de controlar. 
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misma. Son interesantes varios estudios sobre esta técnica invertida, 
pues proyectando una imagen sobre un espejo curvo, permite dar 
proyecciones tridimensionales del espacio proyectado. 

4.7 Fotografía Fisheye de un espacio virtual

Es posible obtener imágenes ojo de pez de una maqueta virtual 
realizada con un programa de animación 3D. Por ejemplo, el plugin 
V-Ray para 3D Studio  permite establecer la cámara de rendering en 
dispositivo fi sheye. De esta forma se posibilita renderizar imágenes 
con una visión de 360º de la escena y distorsión a barril de las líneas 
verticales de un modelo virtual 3D. Esta herramienta nos permite 
analizar proyectos del mismo modo que espacios existentes, y nos 
deja extender la técnica de la fotografía hemisférica a espacios 
urbanos y arquitectónicos todavía en fase de realización. Con este 

Imagen fi sheye de un modelo urbano de Compiègne, realizada con el plugin V-Ray para 3D Studio 

Globoescopio y vista superior de la esfera; http://www.hdrlabs.com/cgi-bin/forum/YaBB.
pl?num=1187252545/10
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Imagen fi sheye de un modelo tridimensional de un proyecto para una vivienda en Castelldefels, realizada 
con el plugin V-Ray para 3D Studio 

4.8 Como construir un objetivo fi sheye casero. [10]

Parecerá raro pero es posible construir un objetivo fi sheye casero. Éste 
seguramente no será un instrumento perfecto y no dará resultados 
fi ables, con ángulos de proyecciones no estándar. En realidad, lo que 
construiremos será un convertidor y será fácil encontrar manuales en 
Internet de cómo hacerlo.
Todo el mundo en casa tiene en la puerta de entrada una mirilla. 
Las tradicionales mirillas están hechas con lentes de doble curvatura, 
como un objetivo retrofocus, ofreciendo una visión muy amplia de lo 
que puede pasar  del otro lado de nuestras puertas.
Un modo para construir adaptadores con efectos fi sheye será buscar 
en cualquiera ferretería una mirilla del mayor tamaño posible y crear 
además un adaptador o “anillo” que pueda enroscarse a nuestra 
cámara.

Objetivo Fisheye casero: http://blog.cow.mooh.org/2010/04/fi sheye-tin-cam.html

instrumento se obtienen imágenes fi sheye circulares y de proyección 
estereográfi ca. De todas formas podemos modifi car las características 
de la foto virtual según nuestros intereses, cambiando las selecciones 
en las propiedades de saque antes de proceder a la elaboración de la 
imagen.  Es fácil entender cómo superponer una imagen fi sheye de un 
modelo virtual a una imagen fi sheye del entorno de un punto puede 
añadir una notable cantidad de información real a un proyecto.   
Este tipo de visión de rendering es usado para estudios con Radiance, 
permitiendo controlar la luminancia en el momento de desarrollar 
un proyecto en toda la escena y registrando todo el entorno de un 
punto.
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[1].http://www.mir.com.my/rb/photography/companies/nikon/nikkoresources/fi sheyes/6mmf28.htm
[2].http://it.wikipedia.org/wiki/Fish-eye
[3].http://photo.net/learn/fi sheye
[4].http://panopticus.altervista.org/fi shlist/fi shlist-mf.htm
[5].http://www.luciolepri.it/lc2/marcocavina/articoli_fotografi ci/Nikkor_fi sheye_story/00_pag.htm
[6].http://webuser.fh-furtwangen.de/~dersch/
[7].http://www.tonipuma.it/tecnica/10.5/index.htm
[8].http://www.superfi sheye.com/
[9].http://hugin.sourceforge.net/docs/manual/Projections.html
[10].http://cow.mooh.org/
[11].http://cmp.felk.cvut.cz/
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La Fotografía Hemisférica para estudiar la cobertura 
del dosel en ciencia forestal

Como anticipamos en el capítulo sobre el objetivo fi sheye, una de las 
ciencias que más ha desarrollado la aplicación de la fotografía para 
estudios sobre la luz, es la  ciencia forestal.
Las imágenes obtenidas con cámaras de video o fotográfi cas equipadas 
con lente hemisférica, orientada hacia arriba, se utilizan para medir 
la cantidad de luz que penetra hasta el suelo de un bosque. Con ellas 
se pueden capturar las diferencias en la arquitectura del dosel, por 
especie, por sitio y por edad, y determinar que parte del cielo es visible 
y cual está siendo obstruida por las copas de los árboles.
Las fotografías hemisféricas pueden usarse para calcular regímenes de 
radiación solar y características adicionales del dosel, como el índice 
de área foliar (LAI), ángulo medio de las hojas a diversas horas del día. 
Cuando se permite la penetración de una gran cantidad de luz solar 
en áreas del dosel, puede llegar a desarrollarse un denso sotobosque.
Después que Robin Hill en el año 1924 usara el objetivo fi sheye para 
estudiar el movimiento de las nubes, recién es en 1959 que Evans y 
Coombe, usan fotografías hemisféricas para estimar la penetración 
a través de la cobertura forestal de la luz solar, sobreponiendo a las 
fotos diagramas polares de la trayectoria solar. Después, entre 1964 y 

1971, Margaret Anderson, teoriza el cálculo de la transmisión directa 
e indirecta de la radiación solar en un bosque, usando fotografías 
hemisféricas. 
Actualmente, con el uso de los ordenadores y la difusión de la fotografía 
digital, la técnica de la fotografía fi sheye para análisis forestales  ha 
pasado a ser frecuente y rápida, siendo aplicada en varios campos de 
ecología, selvicultura y agricultura. Esta técnica permite además la 
creación de registros permanentes, fáciles de consultar, para el análisis 
evolutivo de un sitio o de una especie.
Hoy existen y se han desarrollado varios programas de análisis y 
algoritmos, que facilitan notablemente el trabajo de investigación 
permitiendo un estudio rápido y procesando gran número de 
fotografías. Muchos de éstos son simples en su utilización y varios son 
gratuitos como Scion Image y ImageJ, que pueden descargarse de 
Internet sin costos. Además, hay softwares hechos expresamente para 
el análisis de fotografías hemisféricas del dosel de bosques, pudiendo 
mencionarse el Delta-T Hemi-View, el Tropenbos Hemiphot y el 
Regen WinScanopy, entre otros. Existen, también, plugins para 
Adobe Photoshop. 
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  4.1 Técnica de la Fotografía Hemisférica

La técnica de la fotografía hemisférica es bastante simple y rápida, pero 
hay que conocer el procedimiento, para que no surjan errores. Esta 
prevé cinco fases: toma de la foto, digitalización, registro, clasifi cación 
y cálculo;

Es fundamental para el saque de las fotos que la cámara esté posicionada 
sobre un trípode bien fi rme y que el objetivo esté orientado hacia 
arriba, apuntado perfectamente al cenit. Es preferible usar un nivel 
de burbuja para que la cámara esté perfectamente horizontal. Tiene 
que considerase la posición y la altura de la cámara. Muchas veces es 
preferible tumbarse en el suelo para no salir en la foto. Como puede 
entenderse fácilmente, la presencia de cualquier cuerpo externo 
puede cambiar el análisis, por esto, es aconsejable usar un mando a 
distancia para accionar el saque o usar un temporizador, para darnos 
el tiempo de salir del campo de visión y para que la cámara esté lo 
más fi rme posible. Si las fotos son circulares es aconsejable orientar la 
parte superior de la cámara hacia el norte magnético, para no tener 
problema de orientación al momento del análisis, así la parte superior 
de la foto coincidirá con el norte.
Es muy importante que la escena tenga la mayor uniformidad de 
iluminación posible, por esta razón, los mejores resultados se obtienen 
en días donde la contraluz sea pareja, días con cielo nublado, sin que 
el sol aparezca en la foto, evitando, así, refl ejos en el follaje y áreas 
muy brillantes alrededor del sol. Usos de fi ltros rojos o azules pueden 
ayudar a conseguir mayor contraste entre el follaje y el cielo.
Es preferible sacar fotos con la velocidad de obturador a 1/125 
de segundos y ajustar consecuentemente la exposición. En caso de 
fotografía analógica, películas ISO 400 suelen dar buenos resultados.     

Una vez sacada la foto, tiene que ser digitalizada, en el caso de 
fotografías analógicas éstas tienen que ser pasadas por escáner de 
negativos o un digitalizador de videos.  En el caso de imágenes digitales, 
es sufi ciente  el pasaje de las fotos de la cámara al ordenador.

Después que las imágenes están en formato digital son “registradas”, 
entonces se verifi can las dimensiones, es decir, que el borde coincida 
con el horizonte, centrada de modo que el centro de la foto coincida 
con el cenit y rotada hasta que el norte de la foto sea alineado con el 
azimut y el norte cardinal.  Es importante recordar que el Este y el 
Oeste estarán invertidos, pues el Este estará a la izquierda y el Oeste 
estará a la derecha, en cuanto es una imagen sacada desde abajo, 
invertida a lo que estamos normalmente acostumbrados como las 
proyecciones desde arriba.   

Imagen Hemisférica Binaria de la cubierta forestal [1]
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Una vez registradas, las imágenes son pasadas a programas específi cos, 
donde se realizará la clasifi cación de los píxeles, esto es, la distinción 
de la parte visible cielo desde el área de follaje, luego el cálculo y 
el análisis la foto. Las imágenes pueden ser analizadas para obtener 
diferentes índices, entre éstos distinguimos: el índice geométrico, el índice 
de radiación solar y el índice de cobertura o índice de área de hoja LAI. 

4.2 Índices geométricos

Los índices geométricos son valores dados en relación a la cantidad 
de cielo visible y la cantidad de cielo obstruido en una particular 
“gap fraction”, literalmente “brecha de fracción”,  en función de la 
dirección del cielo, donde el “gap fraction” es una porción de cielo 
visible en un específi co sector de cielo, defi nido por los ángulos cenit 
y azimut.
Normalmente la imagen estará dividida en sectores de cielo y será 
calculada la gap fraction de cada uno de ellos. Una “fracción”, en 
un específi co sector, será igual a 0 cuando el cielo esté totalmente 
obstruido en el sector dado, mientras que será igual a 1 cuando esté 
totalmente abierto.
Se utilizan principalmente dos tipos de sectorización de la imagen, 
una en relación al mapa del cielo y otra en relación al mapa del sol. 
La primera divide la foto en áreas que representan las diferentes 
direcciones, enseñando la variación en el espacio. La segunda divide 
la foto en áreas que representan el tiempo, en cuanto coincide con la 
proyección solar en el año.

Mapa del cielo con los sectores defi nidos por las divisiones 16 cenit y 16 azimut; mapa solar anual de 
39º de latitud norte con intervalos de 0,5 horas a través del día y el mes intervalos durante todo el año. 
http://proceedings.esri.com/library/userconf/proc99/proceed/papers/pap867/p867.htm

Hay estudios que consideran la foto completa como un único sector, 
por ejemplo, para una rápida clasifi cación de la cantidad de luz que 
llega en un dosel forestal. Los científi cos clasifi can como doseles 
abiertos cuando el cielo está obstruido entre el 10-39%  por los 
doseles de los árboles; moderadamente cerrados, el 40-69% del cielo 
está obstruido por los doseles de los árboles, o cerrados, el 70-100% 
del cielo está obstruido por los doseles de los árboles. Esto es lo que se 
defi ne como índice de sitio, que es 0 cuando no llega ninguna radiación 
y 1 cuando llega en su totalidad sin encontrar obstáculos.
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4.3 Índice de radiación solar

Podemos distinguir, principalmente, dos tipos de radiaciones solares: 
radiación directa y radiación difusa. La Directa es la radiación 
del sol que pasa por la atmósfera sin encontrar obstáculos en su 
camino, mientras que la Difusa es la radiación solar difundida por la 
atmósfera.
La suma de las radiaciones directa y difusa es defi nida como radiación 
global o llegada, y es aquella que llega en el punto indirectamente, 
refl ejada por los elementos de la cobertura.
La radiación solar directa en un sito defi nido depende de la posición 
del sol en el día y en el año y de las condiciones atmosféricas, mientras  
que la radiación difusa depende de las condiciones atmosféricas y de 
al ángulo de llegada en el punto en análisis. 
Normalmente, un rápido cálculo de la radiación solar puede hacerse 
sin tener en cuenta la radiación refl ejada, y considerando unos valores 
de radiación hipotéticos que se pueden esperar en un punto dado en 
una dirección dada. Sea para calcular la radiación directa, sea para 
calcular la radiación difusa, se considera el gap fraction de un específi co 
sector multiplicado por al ángulo de incidencia, donde como ángulo de 
incidencia entendemos el ángulo entre una superfi cie y la radiación 
que llega en el punto medido por la normal de la superfi cie. Así, la 
radiación es proporcional al coseno del ángulo de incidencia. Esto es 
fácil de entender en cuanto, una radiación que llega perpendicular 
a la superfi cie, más cerca al cenit, será mucho más fuerte que una 
radiación que llega a un punto cerca del horizonte.

4.4 Índice de Área de Hoja 
 
El índice de Área de hoja, que en sistema internacional se defi ne como 
LAI1, es la cantidad de superfi cie de hoja por la unidad de superfi cie 
de suelo. De este modo, damos una breve descripción en cuanto es 
poco importante para nuestro estudio, pero muy importante en el 
campo forestal, porque se utiliza para describir la fotosíntesis de las 

1  Leaf  Area Index

plantas y la transpiración de las hojas de la cubierta. A su vez, tiene 
aplicaciones en eco-fi siología, en los modelos de balance de agua y 
para caracterizar la interacción entre vegetación y atmósfera. Este 
índice es una relación entre el ángulo cenit y el valor gap fraction en los 
sectores.
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[1]. A.A.V.V., 1994, Hemiview User Manual, Delta-T Devices Ltd, Cambridge, p. 5-19
[2]. Rich Paul M., 1989, A Manual for Analysis of  Hemispherical Canopy Photography, Los Alamos National Laboratory Los Alamos, New Mexico
[3]. Facchi A., Baroni G., Boschetti M., Gandolfi  C.,, Comparazione di metodi per la determinazione dell’indice di area fogliaria (LAI) in un campo a mais, IX Convegno Nazionale 
dell’Associazione Italiana di Ingegneria Agrari,a Ischia Porto, 12-16 settembre 2009, memoria n. 2-29
[4]. Huang Shengli, Fu Pinde, “Modeling Small Areas Is a Big Challenge ,Using the solar radiation analysis tools in ArcGIS Spatial AnalystMay”, ArcUser, Spring 2009, p 28-30
[5]. http://proceedings.esri.com/library/userconf/proc99/proceed/papers/pap867/p867.htm 
[6]. http://en.wikipedia.org/wiki/Hemispherical_photography
[7]. http://en.wikipedia.org/wiki/Leaf_area_index
[8]. http://www1.gifu-u.ac.jp/~ishidam/RGBFisheye.htm
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El análisis del Albedo con técnicas fotográfi cas

Como expusimos en el capítulo 1º, el poder de una superfi cie de 
refl ejar la luz que recibe depende principalmente del tipo de material 
y del color de la misma. Materiales iguales pero de distintos colores 
refl ejan la luz de modo diferente, lo mismo sucede con superfi cies del 
mismo color y diferente material. 

6.1 El Albedo

La luz, como todas las radiaciones electromagnéticas, lleva energía. 
Cuando la luz encuentra una superfi cie, una parte de ella es refl ejada 
y se lleva su energía, mientras otra parte es absorbida. La parte que 
no se refl eja se queda en la superfi cie y la energía que llevaba se 
trasforma en calor. 

El Albedo, del latín albedo “blancura” y álbum “blanco”, de una 
superfi cie es la fracción de luz o de radiación que es refl ejada en todas 
las direcciones. El Albedo indica el valor refl ectante de una superfi cie, 
y el exacto valor de la fracción depende, por el mismo material, de la 
longitud de onda de la radiación considerada [3]. El albedo es una 
forma más específi ca de la refl ectivadad1.
Si el término albedo no está seguido de ninguna especifi cación se refi ere 
a la luz visible.
El valor de albedo es una magnitud adimensional que varía entre 0 
y 1, donde 0 es el valor que se da a un cuerpo negro, ya que es un 
material que absorbe totalmente la luz, y 1 es el valor que se da a un 
cuerpo que es capaz de refl ejar por entero la luz, como podría ser  un 
espejo. El albedo medio de la Tierra es de 0,3 y realmente no existe 
cuerpo con albedo 0 ó 1. La superfi cie con un valor albedo más cerca 
de 1 es la nieve fresca con 0,9, mientras que el valor más bajo es el del 
carbón con 0,04. Muchas veces podemos encontrar el valor albedo 
expresado en porcentual, donde el 100 % equivale a 1.
El Albedo es un concepto muy importante en climatología, en 
cuanto está muy relacionado con la temperatura, ya sea a gran escala 
(energía refl ejada o absorbida por selvas o glaciares, que cambian la 
temperatura del planeta o de grandes áreas), a escala urbana (por 
ejemplo un suelo asfaltado refl eja las radiaciones de modo diferente 
que un suelo cultivado, creando un microclima urbano), o a pequeña 
escala (una camiseta negra al sol absorbe más calor que una camiseta 
blanca).

1  Esta es una magnitud adimensional que representa la relación entre 
intensidad del fl ujo radiante transmitido y la intensidad del fl ujo radiante 
incidente en una superfi cie.
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6.2 Análisis de la cantidad de blanco en una foto

El análisis de la luminosidad de una fotografía digital se hace evaluando 
cuántos son los píxeles blancos que la componen. Normalmente 
defi nimos como píxel apagado a un píxel negro, mientras que píxel 
encendido o luminoso a un píxel blanco. 
En las imágenes digitales cada píxel tiene un valor de luminosidad 
que varía entre 0 y 255. Como en el caso del valor de albedo, el 0 
coincide con el negro, mientras que el valor más alto, en este caso 
255, se refi ere al blanco. Un píxel con valor 0 o cercano a cero, será 
un píxel más apagado u oscuro, mientras al contrario,  un píxel más 
luminoso o claro estará más cerca del valor máximo.  

Fachada Sur de un patio interior de una manzana de Barcelona, en el barrio de Les Corts, en el mes de Agosto con condiciones de cielo semi-nublado

6.3 Ejemplo de análisis de píxeles blancos con ImageJ

Hemos elegido para nuestro análisis una foto de la fachada Sur de un 
patio interior de una manzana de Barcelona, en el barrio de Les Corts, 
para poder rápidamente observar cómo la luz solar que llega en las 
ventanas se refl eja en la fachada norte del mismo patio de manzana 
(punto de saque).

Para evaluar el grado de luminosidad 
de los píxeles se pueden usar 
varios programas de manipulación 
de imágenes, o con las cámaras 
fotográfi cas digitales más modernas 
seleccionando directamente este tipo 
de información en la pantalla.
La luminosidad no depende de los 
colores, si no de la cantidad de pixeles 
blancos y negros, por esto, para hacer 
análisis de la luminosidad de una foto 
se suele trabajar con imágenes en 
escala de grises. Normalmente, una 
vez hecha la foto en color, se convierte 
en blanco y negro o en diferentes 
tonalidades de grises. 
Ya que nuestro ojo como máximo, 
nos permite distinguir alrededor de 
200 diferentes niveles de grises, el 
análisis digital, con 256 tonos, nos 
da una mayor precisión, superior a 
la que normalmente podemos ver y 
distinguir, representando sufi cientes 
variaciones de tonalidades.

De esta foto hemos seleccionado 2 partes, una con predominio de 
ventanas tapadas por toldos verdes, que llamaremos porción 1, y otra 
parte donde las ventanas están abiertas, sin toldos, o con prevalencia 
de toldos más claros, que llamaremos porción 2.
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                                 Porción 1     Porción 2

Se han analizados estas partes de la fotografía con el  programa de 
elaboración de imágenes ImageJ2. Este programa, muy usado en varios 
campos científi cos como ciencia forestal, medicina y astronomía, está 
disponible gratuitamente en Internet y es apto tanto para sistema 
operativo Windows como para Macintosh. Este software permite de 
modo muy simple pasar las imágenes de color (RGB) a imágenes en 
tonos de grises, y después, siempre con el mismo programa, analizar 
el perfi l luminoso de los píxeles de la foto.
Primero hemos convertido la imagen en tonos de grises (Image > Type 
> 8-bit ) y una vez seleccionadas las partes que nos interesaban, con el 
rectángulo de selección de la barra de instrumentos, hemos analizado 
la gradación de saturación de lo píxeles ( Analyze > Histogram).
Se han obtenido de este modo, dos histogramas que representan 
esquemáticamente la distribución de los píxeles en relación a la 
luminosidad.

2  http://rsbweb.nih.gov/ij/

  
       Histograma porción 1   Histograma porción 2

Como se puede observar, los dos histogramas no son muy diferentes 
entre sí, porque las porciones de imagen elegidas, en realidad, no son 
muy distintas a nivel de luminosidad, pero de todas formas serán muy 
útiles para nuestro análisis. 
En ambos fragmentos de la imagen están presentes varios tonos de 
grises: en la porción 1, desde 1 a 242 y en la porción 2 desde 1 a 
252 (notar valores Min y Max abajo de los histogramas). Esta primera 
indicación nos dice ya que en la parte donde los toldos son de color 
más claros (fragmento 2) hay píxeles más luminosos que en la parte 
con toldos verdes (fragmento 1). Podemos advertir, observando tanto 
en los gráfi cos como en el valor Mode, cómo el pico más alto está 
en la primera porción del histograma, en la zona más oscura, hacia 
la izquierda, precisamente 4758 píxeles sobre 458577 en el valor 88 
(relativo a nivel especifi co de gris); mientras que, en la segunda, el 
pico más considerable se encuentra en la zona más clara del gráfi co, 
precisamente a 4747 píxeles sobre 458577 en el valor 168. Podemos, 
además, observar cómo la primera parte de la imagen analizada tiene 
un valor medio de gris de 111, mientras que la segunda tiene un  valor 
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medio de 1203.
Este rápido análisis nos esta indicando cómo los toldos verdes resultan 
más oscuros con respecto a los toldos claros, y cómo los segundos 
están refl ejando más luz en la fachada norte.
 
Nos parece interesante presentar una tercera parte de la imagen (que 
llamaremos porción 3) y analizarla como hemos hecho anteriormente. 
A primera vista, esta tercera porción parece bastante clara y 
esperamos resultados similares a la porción 2. Una vez que obtenemos 
los histogramas, notamos cómo en realidad los resultados son más 
parecidos a la porción 1, la imagen de toldos verdes, que a la de toldos 
claros, contrariamente a lo que esperábamos.

3  Recordamos como los valores son adimensionales porque se refi eren a 
los 256 niveles de gris.  

             
  Histograma porción 3 

Porción 3 Porción 4

Histograma porción 4

Esto demuestra que el análisis no es tan evidente y que nuestro ojo nos 
puede hacer llegar a conclusiones demasiados rápidas y no totalmente 
verdaderas. 
Analizando la porción 3 y comparándola con las otras porciones 
analizadas, notamos, que hay una buena cantidad de píxeles claros 
pero también muchos apagados, que quizás en un primer momento 
no consideramos, que hacen perder una buena cantidad de luz 
refl ejada.
Para fi nalizar, nos parece interesante mostrar cómo la parte de la foto 
que nos da más luminosidad, no es la relativa a las ventanas, si no 
desde el tejado claro del parking.

      

Advertimos así, cómo la cubierta gris del parking  nos da con claridad 
un histograma totalmente diferente de los anteriores, con los picos y 
la media de niveles de gris hacia la parte más clara del gráfi co.
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[1]. Bosetti M.,Galetto M., 2008, Esperimento Albedo, Museo Tridentino di Scienze Naturali, Trento 
[2]. Ferreira, T. & Rasband, W., The ImageJ User Guide –Version 1.43, http://rsbweb.nih.gov/ij/docs/user-guide.pdf, Apr 2010
[3]. Battiato S., 2005, Studio del software Java per l’ Image Processing ImageJ, Dipartimento di Matematica e Informatica, Catania
[4]. http://en.wikipedia.org/wiki/Albedo
[5]. http://it.wikipedia.org/wiki/Albedo
[6]. http://rsbweb.nih.gov/ij/docs/concepts.html 
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La fotografía HDR

El término HDR es una sigla que viene del inglés High Dynamic 
Range, Alto Rango Dinámico, y es una técnica usada en fotografía 
y gráfi ca informática, para realizar cálculos de iluminación en una 
fracción más amplia, alto rango, permitiendo representar valores de 
iluminación muy bajos y muy altos. Una imagen HDR, prácticamente, 
es una grabación digital obtenida mediante una particular técnica 
fotográfi ca/informática y guardada en un archivo gráfi co, capaz de 
contener una paleta de diferentes valores de luminosidad más amplios 
en comparación con la tradicional fotografía digital.
A diferencia del ojo humano, que puede distinguir un rango dinámico 
hasta 10.000:1, el conjunto cámara/ memoria/ pantalla distingue un 
rango dinámico de 255:1, así es que en escenas con mucho contraste de 
luminosidad, como en una escena a contraluz o un atardecer, aunque 
se haya regulado la exposición de modo correcto,  partes de la imagen 
saldrán totalmente blancas, quemadas por la excesiva exposición, y 
partes muy oscuras por falta de luminosidad en estos puntos.  
Con la técnica HDR, trabajando con varias fotos contemporáneamente, 
se consigue obtener un rango dinámico superior al del ojo humano, 



61

 7.1 Diferencias entre la fotografía digital tradicional y la 
fotografía HDR

Una normal foto en JPEG sacada con una cámara cualquiera 
memoriza cada píxel con tres valores, rojo, verde y azul, RGB (red/
green/blu), a 8 bit, que juntos dan el color del píxel, pues más o menos 
16 millones de diferentes colores.  Mientras una imagen RAW, sacada 
con una cámara refl ex, contiene 10 o 12 bit por pixel, entre cuatro y 
ocho veces más defi nición, hablando de valores de luminosidad. En 
una imagen HDR, los píxeles están guardados con valores de 16 o 
32 bit. Esto quiere decir, que los píxeles pueden contener sufi ciente 
información para describir cada variación,  desde la oscuridad 
absoluta hasta una luminosidad mil veces más alta que el sol. [5]

presentando una imagen fi nal mucho más real.
Por esta capacidad de presentar imágenes parecidas a la realidad, 
junto a la posibilidad de ofrecer mayor profundidad en la escena, casi 
tridimensional debida a la elevada posibilidad de contraste, ésta es 
una técnica que se ha desarrollado mucho en el campo de la gráfi ca 
informática, sobre todo en animación virtual y videojuegos.  Los 
primeros videojuegos que utilizan esta técnica fueron lanzados en el  
20041, hoy hay una gran gama de juegos que para mejorar el realismo 
gráfi co utilizan, para detallar la escena, imágenes HDR. Es fácil 
imaginar cómo desde el campo del entretenimiento a pasado a ser 
utilizada en arquitectura, el campo del diseño reenderezado virtual.

También si parece una innovación tecnológica muy compleja y actual, 
esta técnica fue experimentada ya en el siglo XIX2,  para realizar 
vistas de la playa, por Gustave Le Gray, aunque la tecnología de la 
época no permitía mucho. En el año ’40, la técnica fue desarrollada 
y mejorada, tanto que fotógrafos como Charles Wyckoff  la usan para 
poder fotografi ar las explosiones nucleares, pero es a partir de los 
años ’80, que la evolución informática y lo ordenadores permiten una 
mayor aplicación, con la creación de un formato de archivos RGBE 
de radiancia. Actualmente, con la difusión de la fotografía digital y 
softwares de control de imágenes accesibles a todas las categorías de 
público, esta técnica empieza a ser más conocida y difundida, gracias 
a su facilidad y a los óptimos resultados que se obtienen, tanto que 
mucho creen que en un futuro muy próximo, permitirá sustituir el uso 
del fl ash en las cámaras fotográfi cas compactas. Ya varias cámaras3 y 
sistemas portátiles, como el Iphone, ofrecen la posibilidad de sacar 
fotos en HDR sin pasar por un ordenador.     

1  Far Cry y Half-Life 2: Lost Coast.
2  1850 Le Gray (1820-1884), fotógrafo francés,  para realizar la foto de 
paisajes marinos utiliza un negativo para el cielo, y otro con una exposición mayor 
para el mar, y posteriormente combina ambos en una sola imagen en positivo. [7]
3  Pentax K-7 DSLR

Portada revista “TIME” 12 Abril 1954 foto HDR de C.Wyckoff;  
http://www.time.com/time/covers/0,16641,19540412,00.html
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7.2 Realización de una fotografía HDR

Como hemos dicho anteriormente, el concepto HDR, parece muy 
complejo y realizable solamente con sistemas tecnológicos muy 
sofi sticados mientras, que en realidad, es una simple superposición 
y elaboración de tres, cinco o nueve imágenes de la misma escena 
sacadas con tiempos de exposición diferentes. Para obtener una buena 
fotografía HDR hay que seguir ciertos pasos muy simples. 
Primordialmente, hay que buscar una escena  muy contrastada, como 
puede ser un paisaje contraluz, paisajes urbanos nocturnos o una foto 
de interior, para poder aprovechar al máximo las potencialidades de 
esta técnica. Para nuestro ejemplo hemos elegido una foto de interior, 
posicionando la cámara hacia una ventana. Es fundamental el uso 
del trípode, en cuanto la superposición de las imágenes debe ser 

perfecta y no pueden verifi carse movimientos de la cámara, además 
normalmente muchas fotos necesitan tiempos de exposición muy 
largos. Una vez ubicada la cámara sobre el trípode, hay que elegir 
la abertura y sacar varias fotos cambiando el tiempo de exposición, 
obteniendo así, sea fotos sobreexpuestas sea fotos subexpuestas. Hoy 
muchas cámaras refl ex permiten regular el saque de una serie de fotos 
con diferentes valores de exposición. Para nuestra prueba hemos usado 
una cámara refl ex Canon EOS-350D y hemos utilizado el sistema 
AEB (Automatic Exposure Bracketing), que permite sacar tres fotos 
con valores EV diferentes, en nuestro caso -2, 0 y +2. Normalmente 
es aconsejable sacar las fotografías en modalidad “Prioridad de 
Abertura”4.

4  En el modelo de cámara que hemos usado para nuestras pruebas, 
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Una vez sacadas las fotos hay que pasarlas al ordenador y analizarlas 
con un programa de elaboración de imágenes, capaz de fusionar 
las tres fotos en un HDR. Para nuestra tesina, hemos probados tres 
programas diferentes, el Photoshop CS3, el PhotospherU y Qtpsfgui, 
pero hay una gran variedad de softwares que se pueden bajar 
gratuitamente desde Internet y otros que permiten trabajar online, 
en modalidad open, sin que haga falta instalar nuevos elementos en el 
ordenador. Estos programas reconocen y analizan las fotos gracias a 
unos archivos, fi le Exif, que cada cámara digital, graba al momento del 
saque. Los archivos exif, registran cierta información que es posible 
consultar en cada foto, sea al momento del saque sea a posteriori, 
recordando el nombre y la dimensión de la imagen, la escala de 
colores, el tipo de cámara utilizada, la fecha y la hora de cuando ha 
sido hecha la foto, y además la sensibilidad del sensor, el tiempo de 
obturación, la abertura y consecuentemente el valor de exposición 
EV.    

Canon EOS-350D , posicionamos la rueda de los programas en el simbolito “Av”

La imagen obtenida será cargada de información que no aparecía 
en ninguna de las tres imágenes precedentes. Esta imagen, siendo 
un gravado de 24-32bit, no puede ser guardada en un tradicional 
formato JPEG (8-bit), sino en un formato más apto para mantener 
la cantidad de información por píxel obtenido. De estos recordamos 
algunos: radiance RGBE (.hdr); Pixar Log Tiff  (.tif); LogLuv 24-bit; LogLuv 
32-bit ; ILM OpenEXR (.exr); TIFF 48-bi (.tif); Portable Bit Map (.pbm); 
Large Document Format (.psb); IEEE TIFF 96-bi (.tif). Cada uno de estos 
formatos tienen diferentes extensiones, rango dinámico, precisión y 
guardan distintas cantidades de bit por píxel. Los más comunes son: 
el radiance RGBE, que es la extensión más antigua y todavía muy 
utilizada, codifi cando 76 órdenes de magnitud de luminancia con un 
1% de precisión; el Open EXR, desarrollado para superar la limitada 
gama dinámica y la precisión del color en las aplicaciones de creación 
de imagen por el ordenador y está disponible Open Source; el Tiff, 
capaz de guardar hasta 79 gamas dinámicas con una precisión del 
1% y 32bit por cada color en el pixel y es compatible con la mayoría 
de las aplicaciones. [8] 
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7.3 Estudio de la luz con imagen HDR

Hasta ahora hemos hablado de la técnica fotográfi ca HDR, no tanto 
por la calidad de iluminación y la realidad de las imágenes que se 
pueden obtener, sino por la posibilidad que esta técnica nos da de 
cuantifi car la luminancia de los píxeles en términos fotométricos, y 
no simplemente en valores aproximados de claridad u oscuridad de 
una escala de grises5.
Para nuestra tesina hemos utilizado un programa gratuito y de uso 
libre: WebHDR, [8] desarrollado por el investigador londinense Alex 
Jacobs. 

Este es un programa muy fácil de utilizar y es sufi ciente ir a la página de 
Internet: http://luminance.londonmet.ac.uk/webhdr/index.shtml, 
seguir las instrucciones o ver una prueba, cargar imágenes digitales 
que contengan informaciones exif  y que han sido sacadas con cualquier 
cámara digital que permita un buen control de la exposición6, para 

5  Ver capitulo anterior por el calculo del albedo.
6  Es posible en la misma pagina consultar un listado de cámaras 
compatibles

obtener información sobre la luminancia, sea gráfi camente que en 
valores Nit7 (cd/m2), de la escena fotografi ada. 
Este programa ha sido desarrollado para permitir un estudio de 
cualquier ambiente luminoso, de modo fácil y contemporáneamente 
preciso en los cálculos, sin utilizar sistemas sofi sticados y costosos. 
Esta página web permite a cualquier interesado un análisis de la 
luminancia de una escena de modo rápido y sufi cientemente fi able.
Una vez cargadas las fotografías y que el programa analiza la 
compatibilidad, automáticamente obtenemos: una imagen HDR, 
que puede fácilmente descargarse; una imagen en falsos colores, y en 
su margen izquierdo una escala de valores en cd/m2; un histograma 
de la curva de los colores; un polinomio de la curva de respuesta en 
extensión .Rsp, como una matriz de tres líneas, refi riéndose cada una 
a los relativos colores Rojo, Verde y Azul.
A diferencia de otros programas de elaboración de fotos HDR, la 
página que utilizamos nos permite una lectura muy rápida y efi caz 
de los diferentes niveles de luminancia de la escena, procesando una 
imagen en falsos colores, donde cada color en ésta corresponde a un 
intervalo de valores cuantifi cables de luminancia, acompañada de su 
relativa escala métrica.

Como se puede ver en las imágenes del estudio de luminaria, 
realizadas con webHDR, con fotografías de la Gare de l’Est de Paris,  
se pueden obtener dos tipos diferentes de imagen en falsos colores, 
una que marca unos perfi les de las áreas de igual luminancia y otra 
que pinta enteramente las áreas según la cantidad de Nit. Las zonas 
menos luminosas de cada imagen están marcadas en color morado o 
azul, mientras que las zonas más radiantes en color amarillo y rojo.
El programa tiene una limitación en cuanto para una mayor rapidez, 
no analiza fotos con extremos de exposición muy oscuros o muy 
claros, no leyendo y en consecuencia no analizando, en la escala que 
va entre 0 y 255, valores más bajos del 20 y mayores de 200, por esto 
no analiza colores como el negro y el blanco puro.

7  Denominación de la unidad de medida de la luminancia en el Sistema 
métrico internacional, candela por metro cuadrado. 



65

Una vez obtenidas las imágenes en falsos colores es posible trabajar 
sobre éstas, analizar cada punto de la escena con mayor precisión, 
gracias a un extensión, interactive luminance map reader, que nos dice, 
pasando el ratón encima de la foto,  de modo más específi co el valor 
en cd/m2 de cada píxel. 

Foto de la Gare de l’Est de Paris, sacada el 07 de junio 2010 y analizada con WebHDR.

7.4 Estudio de la variación de luminancia a lo largo de un día 
y verifi cación del programa WebHDR.
 
Hemos realizado una serie de 78 imágenes HDR, obtenidas cada una con un grupo 

de 5 fotos, a lo largo de un día. Hemos usado una cámara digital Canon EOS 350-
D con objetivo con longitud focal f  18 y abertura constante de 16. 
Los saques han sido realizados  en el interior de una habitación 
en Compiègne, en el Norte de Francia, el día 26 de junio 2010, 
a intervalos variables de tiempo, con trípode y escena fi ja. Seis 
imágenes sobre siete han sido realizadas en condiciones de luz 
natural mientras la última, con luz artifi cial. 

Los resultados obtenidos revelan una gran oscilación de luminancia, 
que va desde valores máximos en la escala relativa de 4097, 260 cd/
m2, obtenidos en la toma 3, de las 18:19 horas, y valores mínimos de 
1,047 cd/m2, obtenidos en la toma 7, de las 23:44 horas. 

8  En principio se han sacado fotos para 8 imágenes, pero por una de estas, tomada a las 
15:45 horas, el programa no ha podido elaborar el estudio.
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14:57 h 16:44 h 18:19 h

18:51 h 19:29 h 21:40 h 23:41 h
  

Más específi camente, tenemos 
intervalos en la escala relativa de: 
toma1- 14:57 h- 3608,141 max 
189,902 min; toma 2- 16:44 h- 
2343,762 max 123,355 min; toma 
3- 4097,220 max 215, 645 min; 
toma 4- 18:51 h- 3650,510 max 
192,132 min; toma 5- 19:26 h- 
3732,446 max 196,444 min; toma 
6- 21:40 h- 212,287 max 11,173 
min;  toma 7- 23:44 h- 19,908 max 
1,047 min.
Como podemos advertir en las 
imágenes, las zonas más luminosas 
son siempre externas, mientras que 
las zonas más oscuras son la cortina 
de terciopelo azul y la alfombra del 
piso. 
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Para comprobar los resultados que se pueden obtener con el programa 
webHDR, hemos precedido a la toma de las fotos con la lectura 
de 7 puntos de la escena con un luminancímetro Minolta y hemos 
comparado los resultados medidos con los resultados obtenidos en el 
mismo punto con el sistema de mapa interactivo.

 

 

 

Se puede notar cómo los valores elaborados con WebHDR 
son la mayoría similares a los que hemos obtenido con la 
lectura por el luminancímetro. Tal como aconseja el mismo 
programa, una elaboración puede considerarse aceptable si 
la relación luminancia real /luminaria hdr está cerca del valor 1. 
En nuestro análisis hay ciertos valores que han salido muy 
diferentes, probablemente ha sido causado por un control 
incorrecto del luminancímetro. El valor más contrastante se 
ha presentado en la tercera imagen, analizando el punto sobre 
la cobertura de la iglesia al fondo de la escena. Muy probablemente 
en este caso no hemos enfocado bien el lector lumínico al momento 
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de la medición, tanto que el aparato probablemente ha leído los 
refl ejos del vidrio de la ventana. Otros valores muy contrastantes se 
encuentran en la imagen 4, en la medición hecha en la parte alta 
de la cortina. Probablemente esta diferencia es debida al material 
muy oscuro  y absorbente del tapiz que se presenta poco apto a este 
tipo de medición. De todas formas, estamos muy satisfechos de los 
datos obtenidos y consideramos este primer análisis con webHDR 
sufi cientemente fi able y preciso.

[1]. AJ, SW, LG, 2008, Per-pixel Sky Luminance with HDR Photography; Fribourg
[2]. Cheney K., 2008, Image Based Rendering: Using High Dynamic Range Photographs to Light Architectural Scenes, Master of  Science In Architecture, University 
Of  Washington
[3]. Debevec P. E., Malik J., Recovering High Dynamic Range Radiance Maps from Photographs, Computer Science Division, University of  California at Berkeley , http://www.
cs.berkeley.edu/˜debevec/Research
[4]. http://www.abfotografi a.it/articoli/Consigli_Pratici_Fotografi e_HDR.htm
[5]. http://www.3megapixel.it/tips-hdr.html
[6]. http://www.anyhere.com/gward/hdrenc/hdr_encodings.html
[7]. http://www.getty.edu/art/exhibitions/le_gray/
[8]. http://luminance.londonmet.ac.uk/webhdr/index.shtml
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Lectura de la luz con sistemas fotográfi cos

Esta tesina esta compuesta por dos parte, una primera, ya desarrollada 
en los capítulos anteriores, que se ocupa de presentar las herramientas 
de fotografía y dibujo, y una segunda, que intentaremos desplegar en 
este capítulo, donde se quiere formular un método para el análisis de la 
luz, estudiando fotografías.  El desarrollo de esta fase, más experimental 
y investigativa, ha sido realizada gracias a la disponibilidad y el apoyo 
del grupo de investigación AVENUES (Analyses des Vulnérabilités 
Environnementales et UrbainES)  de la facultad de Ingeniería de 
la Universidad de Tecnología de Compiègne, UTC, en el norte de 
Francia. 

8.1 Estudio de la radiación solar directa en un punto

Analizar a través de fotografías, cuándo un punto de un espacio 
arquitectónico recibe luz solar directa o cuándo este mismo está a la 
sombra, es una operación muy fácil de realizar. Para este tipo de estudio 
es sufi ciente tener una fotografía completa del entorno del punto y un 
diagrama adecuado de la trayectoria solar. De esta técnica existen dos 
variantes: una primera, que usa fotografías del espacio, obtenidas con 
cámaras equipada de objetivo a ojo de pez orientada hacia el cenit y 
diagramas polares, y una segunda, que utiliza fotografías panorámicas 
del horizonte y diagramas solares cilíndricos. 
Nosotros, para nuestro análisis, usando como base la técnica de la 
fotografía hemisférica para el estudio del dosel, ya experimentada con 
éxito en ciencia forestal. Hemos utilizado una cámara fotográfi ca con 
objetivo ojo de pez y proyecciones polares del recorrido del sol.
 
Nos valemos de una cámara fotográfi ca compacta modelo Lomography 
Fisheye, analógica de 35mm, tiempo de exposición 1/100 s, con 
objetivo fi jo de distancia focal 10mm, abertura f/8 y campo de visión 
de 170º.  Luego, como aconseja el método hemisférico en los manuales 
de ciencia forestal, hemos utilizado películas de media velocidad 200 
y 400 ISO, para obtener mejor contraste entre obstrucción y cielo y 
para permitir una mejor adaptabilidad del carrete en situaciones de 
poca luz.     
La cámara fotográfi ca que hemos utilizado es una herramienta muy 
económica (su coste varía alrededor de los 40€), fácil de encontrar, muy 
ligera (su peso es de 230 gramos), de muy fácil uso, utiliza películas 
tradicionales y además el objetivo nos deja imágenes circulares de la 
escena de proyección ortogonal, muy apta para estudios científi cos. 
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Como contrapartida, presenta varias  limitaciones en cuanto tiene un 
campo de visión de 170º, no de 180º, deja fuera de la imagen la parte 
de la escena más cerca del horizonte, además siendo analógica, crea 
límites de fl exibilidad y necesita una digitalización a posteriori de la 
película.1

Hemos realizado nuestros estudios en Barcelona (41°22′00″N 
2°10′00″E), en particular en dos plazas del  Barrio de Gracia, y 
en la sede del departamento de Sistemas Urbanos en Compiègne 
(49°25′00″N 2°49′00″E).
 
Una vez sacadas las fotos, reveladas y digitalizadas, las hemos 
comparado con imágenes obtenidas de la construcción de un modelo 
3D y analizado con Heliodon para estar seguros del tipo de proyección 
que nos ofrecía nuestra cámara. Como se puede ver en las imágenes, 
hemos superpuesto los tres diferentes tipos de proyecciones con la foto 
y este coincide casi perfectamente con la proyección Ortográfi ca.  

1  De todos modos nuestra tesis quiere desarrollar e investigar un método 
accesible a todos, por esto hemos utilizado una cámara que fuese principalmente 
barata y al alcance de cualquier persona. 

           

Foto Fisheye del departamento de ingeniería UTC, Compiegne y superposición con proyección 
ortogonal de Modelo en Heliodon

Una vez que estamos seguros del tipo de imagen, pues de la proyección, 
que obtenemos con nuestra cámara nos queda  construir, manualmente 
o por ordenador, un diagrama polar del recorrido solar.
En nuestro caso, hemos obtenido los diagramas por el Heliodon y 
SunTools de SketchUp.
Será sufi ciente superponer una máscara solar a nuestra foto y 
obtendremos un esquema de sombras para todo el año solar, con 
horas y meses. Es importante notar, analizando la imagen, que la foto 
tiene que estar bien orientada y perfectamente horizontal, apuntando 
hacia el cenit. En este caso hemos elegido una foto con cielo tapado de 
modo que haya mucho contraste entre el cielo y las obstrucciones. El 
este y el oeste están “invertidos”, en cuanto la foto es una imagen desde 
abajo, mientras normalmente las proyecciones son representaciones 
de la bóveda celeste vista de arriba. 

Las horas que aparecen en el diagrama marcan el tiempo solar, que 
no coincide con el tiempo “civil” de nuestro reloj. Será necesario, 
dependiendo de la temporada y la posición del lugar, considerar la 
presencia o no de hora ofi cial y la posición en relación al huso horario. 
Por ejemplo, en una foto sacada en Barcelona en verano habrá que 
añadir a la hora marcada en la máscara una hora, debido a la hora 
ofi cial europea, y una hora debido a la posición, en cuanto Europa regula 
sus relojes en relación a las horas solares  de Berlín, unos grados más 
al Este de la capital catalana.

Proyecciones de Modelo en Heliodon: Equidistante; Estereografi ca; Ortogonal;
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Superposición de un diagrama polar a una foto fi sheye de un porche del departamento de Ingeniería de 
Sistemas Urbanos en Compiègne (Francia) 49°25′00″N

Observamos cómo el punto de saque potencialmente recibe 
iluminación solar directa casi todos los días del año, a todas las horas, 
menos que una pequeña fracción de tiempo, entre las 14 y las 15, 
horas solares, en el mes de Junio, que recibe sombra de la cubierta 
superior, y en las últimas horas del día en los períodos invernales, 
cuando recibe la sombra del pequeño tejado al sur-oeste.   

N

E W

S

Hemos analizado también, fotos sacadas el día 04 de agosto de 2010 
a las 15:00 hs., hora civil, en la Plaça de la Villa, ex Plaça Rius i 
Taulet, en el Barrio de Gracia en Barcelona (41°22′00″N). Hemos 
estudiado juntas una foto sacada hacia el cielo, con cámara ubicada 
horizontalmente, y una foto con vista hacia el oeste, con cámara 
vertical. A las dos imágenes hemos superpuesto unos diagramas 
polares de la trayectoria solar con vistas horizontal y lateral. Ambas 
fotos están sacadas a una altura de un metro del suelo, por esto 
en la vista lateral la línea de horizonte no coincide con el nivel del 
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Fotos Fisheye Plaça de la Villa, Gracia, Barcelona, vista polar ortogonal superior y lateral de la 
trayectoria solar. 

suelo. Desafortunadamente, la imagen vertical, hay que tomarla 
de forma orientativa, en cuanto se ha cometido un pequeño error 
de inclinación de la cámara al momento del saque; la foto no está 
orientada exactamente hacia el horizonte sino un punto hacia arriba. 
Este error se manifi esta en  que la obstrucción del edifi cio al sur-oeste 
no proyecta exactamente la misma sombra, en hora y mes, que en la 
proyección del cielo.
La vista lateral, fundamental para la construcción del diagrama polar 
ortográfi co, en realidad añade poca información a nuestro análisis. Si 
bien, con  ella se puede compensar la falta de información en la parte 
más extrema de la vista horizontal, nos brinda la mitad de información 

en cuanto encuadra solamente una parte de la bóveda, la oeste o la 
este. De todas formas, puede resultar muy interesante, superponer los 
diagramas laterales a una foto de una ventana, para saber cuándo y 
cómo el sol puede incidir en ésta. 
Actualmente, con el uso del ordenador, es muy fácil obtener diagramas 
que responden a cualquier tipo de orientación e inclinación. En 
particular, hemos encontrado un plugin de SketchUp muy interesante, 
el Sun Tools2 , que trabajando en tres dimensiones resulta muy fl exible, 
inmediato y fácil de entender. 

2  http://tx.technion.ac.il/~arrguedi/SunTools/download.html
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8.2 Cálculo del factor de vista con fotografía fi sheye

Saber cuánto porcentaje de cielo es visible desde un punto, puede 
resultar interesante para entender cuánto un entorno construido 
puede afectar en un punto determinado de una escena. 
Si tenemos, por ejemplo, una ventana abierta, es fácil entender 
cómo la cantidad de luz que entra a través de ésta será diferente si la 
abertura tiene en frente un edifi cio o si tiene delante un espacio libre. 
El porcentaje de cielo visible en la totalidad de la escena se llama factor 
de cielo, y será máximo cuando la escena esté totalmente despejada y 
mínimo cuando presente más obstáculos. Hay normativas, como la 
inglesa, que recomiendan calcular el factor de cielo para prever el 
impacto en el entorno de nuevas construcciones3[1].
En realidad, no todo el cielo que está en frente de una ventana incide 
de la misma manera. Una porción de cielo que está justo en frente 
de nuestra ventana dará más luz que si la misma porción estuviese 
tangente a la abertura.  Como sucede con la radiación directa, la 
cantidad por la cual el cielo ilumina una superfi cie depende del ángulo 
de incidencia. El factor de cielo ponderado por el ángulo de incidencia4 
se llama factor de vista.
Si recordamos las diferencias entre las varias proyecciones polares de 
la bóveda celeste, tendremos presente como la proyección Ortogonal 
representa de modo diferente porciones iguales de la escena en 
relación a su ángulo de incidencia. Un elemento cualquiera, que se 
encuentra en posición más angulada en la escena, es representado en 
la imagen de modo mucho más pequeño de como nos aparecería si 
este mismo estaría posicionado cerca del cenit. Por esta característica, 
las proyecciones Ortogonales son aptas a un análisis de factor de vista, 
en cuanto ya ponderadas por el ángulo de incidencia.   
La cámara fi sheye, que hemos utilizado para sacar nuestras fotos, nos 
da imágenes con proyección Ortogonal que nos permiten calcular de 

3  El software Heliodon, nos permite calcular el factor de cielo (Sky factor), 
analizando proyecciones equidistantes, pasando del modo “sol” al modo “cielo” y 
es posible visualizarlo sea con valores sea de forma grafi ca.
4  El ángulo de incidencia es una medición en grados de la incitación de 
un objeto de la posición de referencia en relación a su Normal.

modo rápido los factores de cielo.
Como ya hemos hecho en el capítulo cinco, para calcular el Albedo 
en una fotografía, utilizaremos para desarrollar nuestro nuevo análisis 
el software libre ImageJ5.

Foto Fisheye Circular Ortografi ca del departamento de ingeniería y superposición con mascara 
Ortografi ca de la bóveda celeste. 

Para proceder con nuestro primer análisis hemos elegido una foto 
fi sheye sacada en Compiègne, el día 3 de Mayo del 2010, a las 16:30 
hs., en condiciones de cielo cubierto, para favorecer  un mayor 
contraste entre cielo y obstrucciones.

5  http://rsbweb.nih.gov/ij/
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Abierta la foto con ImageJ (File>Open) la hemos pasado a una imagen 
en escala de gris a 8 bit (Image>Type>8-bit). Luego,  seleccionamos la 
parte de imagen que nos interesa, en este caso tratándose de una foto 
fi sheye circular, hemos utilizado el seleccionador circular, y contamos 
la cantidad de píxeles que componen la totalidad de la imagen 
seleccionada (Analyze>Measure). Se abre una ventana con diferentes 
valores, el primero indica el área en píxel. En nuestro caso la superfi cie 
seleccionada cuenta con 2.003.169 píxeles. Es importante estar seguros 
que esté seleccionada la modalidad Área (Analyze>Set Mesuarement). 
Luego hay que marcar los límites de gris, de modo de evidenciar lo 
que queremos contar y que resulten distintos, así el software pueda 
distinguirlos cuando los vaya a contar  (Image>Adjust>Threshold). 

Análisis del factor de vista con ImageJ, búsqueda de los limites de gris. 

Seleccionamos los valores, en nuestro caso de 125 a 255, que coinciden 
con los valores del cielo y aplicar. Se vuelve a repetir la operación de 
medición (Analyze>Measure). Obtendremos un nuevo valor en píxeles 
de la cantidad del área del cielo, 1186011 píxeles. En conclusión, 
sabemos que en la imagen 1.186.011 sobre 2.003.169 píxeles, 
coinciden con el cielo, es decir, el 59% de la imagen. Este último 
porcentaje coincidirá con nuestro factor de cielo. Hemos desarrollado 
el mismo análisis del factor de vista con los simuladores virtuales 
Heliodon y Sun Tools, de lo que hemos obtenido como resultados el 
58,9% y el 54% respectivamente. La diferencia entre el porcentaje 
obtenido por medios fotográfi cos y los porcentajes que resultan de 
Sun Tools, es debido al hecho que en nuestro análisis consideramos el 
cielo visible a través del cristal, mientras que esta parte es considerada 
en la simulación virtual como obstrucción.

Análisis de factor de vista con Sun Tools de SketchUp

Análisis de factor de vista con Heliodon
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8.3 Análisis del cielo en relación a la vegetación

Hemos querido analizar cómo puede cambiar el factor de vista de un mismo punto 
en relación al cambio de la vegetación en diferentes temporadas, sacando dos fotos 
en el mismo espacio en distintas épocas del año. El sitio elegido, Plaça Raspall, en el 
barrio de Gracia,  presenta un grupo de siete árboles de altura media de 15 metros 
aproximadamente, en verano ricos en hojas y en invierno totalmente desnudos. La 
plaza es sufi cientemente tranquila y eso nos ha permitido hacer todas las mediciones 
necesarias para la toma de las fotos, además presenta unas marcas en el suelo que nos 
han permitido reconocer el punto de saque después de unos meses. 

  
Plaça Raspall, Barrio de Gracia, Barcelona; imagen obtenida por el Google Street View  

La primera foto la hemos sacado el 2 de febrero del 2010 a las 16.00 horas, en un día de 
cielo azul despejado y una temperatura del aire de 15º grados, mientras que la segunda 
foto ha sido sacada seis meses de después, el 4 de agosto a las 15.00 horas, en un día de 
cielo variable con temperatura del aire de 27º. 

Fotos fi sheye Plaça Raspall, Barrio de Gracia, Barcelona, 02/02/2010 – 
04/08/2010



79

Ambas fotos han sido analizadas con el programa ImageJ y una 
técnica de cuentas de píxeles de colores. Hemos cargado las imágenes 
(File>Open) y esta vez hemos seguido nuestro análisis sin pasar las 
imágenes en escala de grises. El hecho que el cielo estuviese despejado, 
no nos ha ayudado en cuento no hay sufi ciente contraste, entre el 
cielo y las obstrucciones, además, en el caso de la foto de invierno, 
hay edifi cios mas claros que cielo. Por esto ha sido necesario marcar 
límites de colores, no de grises, para evidenciar la zona que queremos 
contabilizar (Image>Adjust>ColorThreshold).

Una vez marcados los límites y realizada la máscara es sufi ciente 
seleccionar las áreas y medirlas (Analyze>Measure). Comparando las 
cantidades de píxeles con el área total, conoceremos el porcentaje 
y consecuentemente el factor de vista. En nuestro caso específi co, 
hemos comprobado que en el punto elegido de la Plaça Raspall, 
en invierno el cielo cuenta aproximadamente 790.366 píxeles sobre 
1.360.032 totales, pues un 58% de factor de vista, mientras que en 
verano el cielo cuenta 219.228 píxeles sobre 1.254.828, un 17% de la 
totalidad.6

6  La diferencia de la cantidad de píxeles totales, 1.360.032  contra  

En conclusión las copas de los árboles infl uyen un 41% en el factor 
de vista, pues en invierno tendremos un 41% más de luz que llega del 
cielo. Además, superponiendo a las fotos la máscara solar de Barcelona, 
notamos cómo en verano las hojas de los árboles no permiten a los 
rayos solares alcanzar el punto de saque. Se advierte, cómo un cálculo 
de este tipo hecho con simulación por ordenador será mucho más 
aproximado, en cuanto es muy difícil pronosticar el crecimiento de 
las plantas, en cambio las fotos nos ofrecen una imagen real de las 
obstrucciones en el punto.

1.254.828, es debida a una diferente calidad en el momento de digitalizar las 
fotos.
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8.4 Valuación de píxeles para análisis de cielo

Usando el método de la fotografía fi sheye, quisimos comparar cómo puede variar la 
cantidad de luz que llega en un punto y cómo cambian las refl exiones en el entorno 
del mismo. 
Hemos analizado una serie de fotos sacadas en Compiègne en dos puntos diferentes 
del centro de investigación, punto A y punto B. La toma de las fotos ha sido integrada 
con mediciones de luz global, sirviéndonos de un luxómetro CHAUVIN ARNOUUX CA813, 
y mediciones de la temperatura en diferentes puntos, gracias a un termómetro Fluke 
62 Mini.
En el punto A hemos realizado 3 fotos en diferentes días, cada una en condiciones 
atmosféricas diferentes: un día totalmente nublado, un día totalmente despejado con 
luz directa, un día en parte nublado y sol tapado. En el punto B, al contrario, hemos 
sacado y analizado 2 fotos en el mismo día pero con variaciones de luz: luz directa y 
luz indirecta.
Una vez digitalizada las fotos, las hemos elaborado con el programa ImageJ. Para 
facilitar el cálculo, hemos pasado las imágenes originales desde color RGB a escala 
de gris 8-bit  (Image>Type>8-bit). Siendo que el programa nos propone una variación 
de 256 tonalidades diferentes de grises, variación no distinguible por el ojo humano, 
hemos acentuado las diferencias que lee el ordenador asignando a pequeños rangos 
de luminosidad otros colores netamente diferentes (Image>Lookup Tables> 16 colours). 
Esta específi ca herramienta coge los 256 tonos de grises y los divide en 16 partes 
(256/16=16) y asigna el color según el nivel de saturación de este modo:

0    <= Pv < 16 Negro
16  <= Pv < 32 Azul oscuro
32  <= Pv < 48 Azul
48  <= Pv < 64 Cian oscuro
64  <= Pv < 80 Cian
80  <= Pv < 96 Cian claro
96  <= Pv < 112 Verde
112<= Pv < 128 Verde ácido

128<= Pv < 144 Amarillo
144<= Pv < 160 Amarillo claro
160<= Pv < 176 Naranja
176<= Pv < 192 Naranja oscuro
192<= Pv < 208 Rojo
208<= Pv < 224 Fucsia
224<= Pv < 240 Lila
240<= Pv < 256 Blanco



81

Imagen de 16 colores de ImageJ

Como se puede ver en las imágenes, aparece muy evidente como varía 
la luminosidad en las diferentes partes de éstas y será sufi ciente realizar 
un histograma, seleccionado antes el círculo de la foto, para saber 
cómo cada rango de luminosidad infl uye en el conjunto de la foto. 
Nos parece interesante evidenciar, cómo la luz que alcanza el punto 
no viene únicamente desde el cielo sino también de los elementos 
arquitectónicos que la refl ejan.
Si queremos, además, cuantifi car el peso, en porcentaje, de cada color 
en la totalidad de la imagen podemos guardarla en cualquier tipo 
de extensión y analizar esta última con un plugin específi co, Color 

Inspector, que se puede bajar libremente de Internet7.
Una vez instalado el plugin, tenemos que abrir la imagen guardada 
(File>Open) y abrir el plugin (Plugins>Color Inspector 3D). La ventana 
que aparece presenta una visión tridimensional de la distribución 
de color en la imagen. Cambiando el Display Mode en Median Cut 
y bajando la cantidad a 16, sabemos cuánto cada color, (pues cada 
nivel de luminosidad), infl uye en la escena. Pasando con el ratón en 
una parte cualquiera de la imagen, el programa nos está diciendo 
la posición, el tipo de color y el porcentaje (frequency) en relación 
al conjunto. El esquema tridimensional RBG nos está dando una 
rápida representación gráfi ca de las proporciones entre los colores. 
Con el ratón, se puede rotar el gráfi co para verlo de modo óptimo.  
Pinchando el botón LUT, tendremos un listado de los valores que 
buscábamos.  

Es fácil entender cómo comparando los valores tomados por un 
luminancímetro podemos saber, cuándo, dónde y con qué porcentaje 
una determinada cantidad de luz incide en un punto.

7  http://rsb.info.nih.gov/ij/plugins/color-inspector.html 
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8.5 Fotografías HDR fi sheye y valuación de píxeles

Nos parece muy interesante presentar una técnica para analizar el 
cielo y el entorno en un punto, en este momento pionera pero que 
dentro de algunos años será, seguramente, importante en estudios 
del cielo y energía solar, que mezcla las posibilidades que nos da la 
fotografía hemisférica con las sorprendentes potencialidades de las 
imágenes digitales HDR. 
A causa de los elevados costos de los objetivos ojo de pez para 
cámaras digitales, hemos tenido que utilizar pequeños trucos de 
ordenador para poder experimentar lo que sigue a continuación. 
Por esto, no hay que considerar totalmente fi ables los valores que 
hemos obtenido y habrá que tomar esta parte como el intento 
de formular un método, más que como un estudio puramente 
científi co8.  
Teniendo un mínimo de tres imágenes fi sheye de la bóveda celeste 
sacadas con tiempo de exposición diferentes es posible obtener 
fotografías de alto rango dinámico que pueden ser analizadas con 
programas, como el WebHDR, como presentamos en el capítulo 8 
de esta tesina, y realizar elaboraciones de valores de luminancia en 
una escena. 

8  Por el hecho de haber utilizado una cámara analógica compacta que no 
nos permite modifi car el tiempo de exposición en saque de una foto y en cuanto 
la digitalización y las informaciones Exif, fundamentales para el análisis de imagen 
HDR, están hechas posteriormente al saque, ha sido necesario cambiar los valores  
de exposición con el Photoshop y construir unos archivos Exif  manualmente.

  

Con el análisis de WebHDR conseguimos 
cuantifi car en cd/m2 todo el entorno a 360º, 
sabiendo cuales son las porciones de cielo más 
o menos luminosas, y cual parte del construido 
puede refl ejar u obstruir la luz que llega en el 
punto, sin que sea necesario un cálculo de la 
luminancia con sofi sticados instrumentos.
Una vez elaborada la imagen gráfi ca y la escala 
de valores se puede pasar al análisis de píxeles 
con ImageJ para saber en qué porcentaje infl uye 
cada fracción de luminancia.
Abriendo la imagen guardada desde WebHDR, 
seleccionado el círculo de la foto, es posible 
analizar la imagen en color con el plugin Color 
Inspector (Plugins>Color Inspector 3D).

EV +2 EV +0 EV -2

Imagen falsos colores del Análisis de luminancia obtenida con WebHDR 
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Esta vez hemos divido la imagen en 10 colores, tantos cuantos son los 
intervalos de valores que obtenemos con WebHDR.    

En particular en nuestra imagen analizada sabemos que en el punto 
de saque se refl eja: el 2,452 % de luminacia superior/igual a 2172 
cd/m2; el 5% entre 1944 y 1715 cd/m2; el 6,6% entre 1715 y 1029 
cd/m2; el 11,6% entre 1029 y 800 cd/m2; 10% entre 800 y 572 cd/
m2; el 28% entre 572 y 114 cd/m2; 36 % igual o inferior a 114 cd/
m2;  

  Pixel %
1 14588 6.587
2 14956 6.753
3 21288 9.612
4 59087 26.680
5 32792 14.807
6 22147 10.000
7 29300 13.230
8 11185 5.050
9 10692 4.828
10 5430 2.452

4

5

6

7

8

9

10

1

1

2

3

Análisis de pixel con ImageJ de la imagen obtenida con WebHDR  
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Instrumentos fotográfi cos portátiles para el análisis de 
un sitio

En el desarrollo de nuestra tesis hemos encontrado ciertos instrumentos 
que permiten un análisis del sitio en relación a su entorno, utilizando 
técnicas fotográfi cas, dotados de pequeñas cámaras internas o externas 
al dispositivo. La mayoría de estas herramientas están producidas 
y comercializadas para la instalación de paneles solares, y algunos 
utilizan sistemas muy simples y convencionales. Nos ha parecido 
interesante dedicar un pequeño capítulo a estos instrumentos en 
cuanto su comercialización expresa las posibilidades de nuestro 
método. En particular, presentaremos ciertos productos, fabricados 
por diferentes marcas, que nos han parecidos muy interesantes y de 
fácil utilización.
Empezaremos nuestra exposición con el más simple e intuitivo, 
pasando poco a poco a sistemas más complejos y dotados de tecnología 
más sofi sticada.
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9.1 Solar Pathfi nder ™ [1]
 
El Solar Pathfi nder, producido por una empresa de  Estados Unidos, 
es un instrumento muy simple en su estructura y utilización. Es 
una herramienta no electrónica que funciona por refl exión y sirve 
para determinar la sombra dada por el entorno en punto. Éste esta 
formado por una cúpula semitransparente de plástico, de alto poder 
de refl exión, y unos discos que representan la trayectoria solar. Se 
ubica la cúpula sobre un trípode en el punto que queremos estudiar 
y se posiciona debajo de la bóveda traslucida ciertos elementos que 
representan los diagramas polares de la trayectoria solar. El dispositivo 
está dotado de una brújula para un correcto posicionamiento. Una 
vez colocado en el sitio para analizar, el usuario tendrá una visión 
panorámica del entorno como refl ejo en la cúpula, será sufi ciente 
sacar una foto con  cualquier cámara digital de la refl exión.   
Estando privado de electrónica, esta herramienta se podrá usar en 
cualquier lugar y en cualquier condición atmosférica. Los discos de los 
diagramas solares son intercambiables y los proporciona el productor 
al momento de la compra. El Solar Pathfi nder se puede comprar por 
Internet y tiene un precio relativamente bajo, aproximadamente de 
300 $ por el kit. 
Una vez sacada las fotos y pasadas por ordenador, las imágenes serán 
elaboradas por un programa informático, Pathfi nger Assistence Software, 
que gracias a archivos internos permite ofrecer varias posibilidades 
para el cálculo medio ambiental y las instalaciones de energías 
renovables.
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9.2 HORIcatcher [2]

Producido por la industria Suiza Meteotest,  HORIcatcher es un 
instrumento para el estudio de las obstrucciones y los obstáculos a 
la llegada de la radiación solar directa en un punto. Como la Solar 
Pathfi nger, este sistema trabaja por refl exión siendo como el tradicional 
globoscopio, formado por un espejo curvo, que refl eja los elementos 
presentes en la escena alrededor del punto analizado y un especial 
brazo donde está colgada la cámara digital que graba en imagen la 
refl exión del espejo.
Una vez obtenidas las fotos, son elaboradas por un software para PC 
Window, MeteoNorm, que analiza las imágenes obtenidas y permite 
el cálculo de irradiación y soleamiento. La cámara y el espejo están 
posicionados encima de un normal trípode fotográfi co, que permite 
la regulación horizontal gracias a un nivel de burbuja y una brújula.
HORIcatcher, se puede ordenar por Internet y tiene un precio que varia 
entre los 900 y 1000 $.  
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9.3 Panorama Master [3]

Panorama Master, producido por la empresa suiza EnergieBüro,  es un 
especial trípode que nos permite un control de la cámara fotográfi ca 
para fotos panorámicas. Esta herramienta va acompañada de un 
software de análisis de imagen, HorizOn, producido por la misma 
casa, que permite realizar fotos panorámicas en modalidad stitcher, 
juntando una serie de varias fotos, para obtener una de 360º alrededor 
del punto, marcando en la imagen las diferentes trayectorias solares y 
elaborando la cantidad de horizonte libre. Este sistema, a diferencia 
de los que hemos presentado anteriormente, utiliza para el análisis 
proyecciones del entorno y diagramas cilíndricos y no polares1.
Este producto se puede comprar online y tiene un valor, alrededor de 
300 €.

1  Ver capitulo sobre los diferentes tipos de proyecciones.
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9.4 SunEye [4]

Producido por la empresa estadounidense SolmetricTM, SunEye es un 
pequeño instrumento electrónico portátil que permite evaluar el 
potencial de energía solar total dado por la sombra de un determinado 
sitio. Este aparato está presente en el mercado desde el 2006 en dos 
modelos, SunEye 110 y SunEye 210, y es muy usado, sobre todo en los 
Estados  Unidos, por muchos instaladores de paneles solares.
Los dos sistemas están dotados de una pequeña cámara fi sheye que 
permite la visualización del entorno, y gracias a un sistema interno 
admiten procesar las imágenes en el momento. Tiene   navegador 
satelital gracias a un sistema GPS, externo en el caso del modelo 
110 e integrado en modelo 210, y mantiene la perfecta posición en 
cuanto está equipado de una brújula y un nivel de burbuja. Gracias 
a una pequeña pantalla de diferente resolución para los dos modelos, 
permite visualizar de modo muy rápido, los diagramas de trayectoria 
solar y de sombra. Produce una primera estimación de la cantidad 
de radiaciones potenciales en unos meses o en un año y procede a la 
elaboración de unos histogramas. El modelo 210, gracias a un nivel 
de burbuja electrónico, permite calcular los cambios de porcentaje 
de irradiación con el cambio de inclinación. Toda la información es 
almacenada en una pequeña memoria interna y luego pasada a un 
ordenador (compatible con sistemas Windows) por un puerto USB. El 
coste de esta herramienta es relativamente elevado si lo comparamos 
con los sistemas fotográfi co más simples presentados anteriormente, 
y puede variar entre 1.500 $, para el modelo 110, y 2.500$, para el 
modelo 210. Los dos se pueden comprar por Internet pero el SunEye 
210, actualmente, está disponible a la venta únicamente para el 
territorio estadounidense.
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9.5 Solmetric IPV iPhone App [4]

Nos parece interesante presentar por último una aplicación de iPhone, 
adquirido este año por la empresa SolmetricTM. Ésta es una aplicación 
menos precisa que otras que produce la misma casa, pero nos parece 
interesante observar cómo el cálculo solar ha entrado a ser parte de 
nuestra vida cotidiana y cómo un teléfono, por lo sofi sticado que sea, 
nos permite dar un primer análisis de un sitio desde el punto de vista 
solar.  
Solmetric IPV, es una aplicación de iPhone que nos permite una 
evaluación de un lugar y memorizarlo en nuestro teléfono móvil. 
Este permite consultar los datos metereológicos de todo el mundo y 
varias gamas de paneles fotovoltaicos. Utilizando la brújula interna 
del iPhone y el inclinómetro, permite un análisis rápido, dibujando 
el contorno de nuestro horizonte en la pantalla con un cursor a cruz. 
Utilizando una estación meteo basada en el sistema Solmetric IPV 
produce una primera estimación de la energía solar mensual que 
llega en un punto. Permite realizar perfi les de sombra, una previsión 
de la energía que llega, el rendimiento y la producción de un panel 
por cada mes. 
La aplicación se puede bajar de Internet y es muy económica, con un 
gasto de 30 $ se puede tener un instrumento de control en cualquier 
lugar y momento.



94

 
[1]. http://www.solarpathfi nder.com
[2]. http://www.meteotest.com
[3]. http://www.energiebuero.ch
[4]. http://www.solmetrics.com
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Conclusiones

Cuando comenzamos este trabajo, nuestro principal objetivo era 
desarrollar un método que nos permitiese estudiar la luz directa y 
las sombras en un punto de un espacio arquitectónico, sobre la 
base de la técnica de la Fotografía Hemisférica usada en los estudios de 
ciencia forestal. A medida que fuimos avanzando en el análisis de las 
referencias y estudiando las varias  aplicaciones, nuestros intereses se 
ampliaron hacia nuevos objetivos y temas más complejos. Durante 
la permanencia en Compiègne (Francia) hemos recibido diversos 
estímulos por parte del mundo científi co que se ocupa actualmente del 
análisis medio ambiental en sistemas urbanos, que han infl uenciado 
tanto nuestra curiosidad, siendo capaz de orientar nuestra atención 
desde un simple análisis de la luz directa hacia un más amplio campo 
de estudio de la luz indirecta. 
El interés manifestado por parte de varios profesionales, investigadores 
y fotógrafos, por nuestro análisis ha demostrado la validez del tema. 
Asimismo, la cantidad de publicaciones y material que hemos ido 
encontrando a medida que el argumento se profundizaba, indican  la 
actualidad de su contenido. 

El interés y el desarrollo que en los últimos años se ha mostrado por 
parte del mundo universitario y de la industria por el tema, manifi esta 
un futuro cierto para esta técnica. En efecto, muchas empresas que 
se ocupan de producir herramientas para el control de la luz natural 
para instalaciones de fuentes de energía renovable, están desarrollando 
nuevos dispositivos, cada vez más sofi sticados, que contienen en su 
interior una pequeña cámara digital. En el Workshop que ha tenido 
cita en Compiègne en el mes de Mayo 20101, muchos investigadores 
provenientes de varias partes del mundo, expertos en el análisis de la 
Energía Solar a Escala Urbana, han presentado como importantes 
para sus estudios técnicas fotográfi cas de visión extrema. 

Como resultado de nuestra investigación, hemos conseguido 
desarrollar un método que nos permite analizar con facilidad un 
punto de un espacio construido, sea para el análisis de la luz directa, 
sea para el análisis de la luz indirecta. 
Resulta bastante simple e intuitivo controlar el soleamiento en el 
punto de saque. Para este análisis será sufi ciente tener una fotografía 
fi sheye del cielo, prestando atención en el correcto posicionamiento 
de la cámara, disponer de la adecuada información sobre el tipo de 
objetivo usado y de las máscaras de la trayectoria solar en el sitio por 
su latitud.
El análisis del cielo resulta un poco más laborioso. Programas para la 
evaluación de los píxeles nos ayudan a evidenciar la parte de cielo, y 
contar el porcentaje de éste en relación a la totalidad de la foto para 
obtener factores de vista.

1  SEUS, Solar Energy at Urban Scale, 25 y 26 Mayo 2010
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Desde el principio sabíamos que un análisis del punto hecho con 
fotografías podía dar resultados más reales y precisos de los que se 
pueden obtener con simulaciones del ordenador. En particular, 
estamos muy satisfechos de haber conseguido realizar el análisis 
del factor de vista en el mismo punto en diferentes épocas del año, 
comparando las disímiles condiciones de luz debido a la variación 
de la vegetación. Siendo muy complejo prever el crecimiento de las 
plantas, consideramos que la técnica fotográfi ca es un modo muy 
exacto para determinar la infl uencia de la vegetación, por la luz y 
la sombra, en un espacio arquitectónico. En nuestra opinión, resulta 
importante, con fi nes de investigación científi ca, poder disponer de 
un rico archivo fotográfi co que permita comparar los cambios de 
iluminación en diferentes condiciones de luz. El hecho de ser capaces 
de elaborar los valores de luminancia del cielo y del entorno, nos 
permite controlar con elevada precisión lo que sucede alrededor del 
punto analizado a medida que las condiciones atmosféricas vayan 
mutando. 
Hemos conseguido cuantifi car qué porción de la escena refl eja, 
hacia la cámara, un determinado intervalo de luminancia, pudiendo 
así, estudiar dónde, cuándo y con qué porcentaje los diferentes 
componentes infl uyen en un punto. Esto nos permite considerar los 
elementos construidos, no solo como obstrucción al paso de la luz, si no 
como pantallas refl ectantes, dependiendo del material y de la forma, 
para un mejor aprovechamiento de los rayos electromagnéticos. 
La moderna fotografía digital nos permite, además, registrar un 
elevado número de fotografías para comparaciones y análisis. En 
particular, una monitorización constante y puntual del cielo, puede 
ayudar a comprender los repentinos saltos de niveles de radiación, 
que todavía resultan poco claros a los investigadores, que aparecen en 
las mediciones de la bóveda con piranómetro.
Para nuestro trabajo, hemos elegido realizar un método de análisis 
simple y accesible a cualquier tipo de usuario y por ejemplo, hemos 
utilizado una cámara analógica para los saques de imágenes a ojo de 
pez, de bajo coste y fácil de uso. Este tipo de elección si bien nos ha 
permitido cumplir con nuestro objetivo, ha resultado al mismo tiempo 
una limitación para otros estudios. Disponer de una lente fi sheye para 

nuestra cámara digital hubiese permitido mayor rapidez en nuestro 
análisis. En particular, trabajar con imágenes digitales nos hubiese 
permitido profundizar las posibilidades de la elaboración HDR, que 
en nuestra tesina se presenta con un ejemplo en capítulo 8º.
De todas formas consideramos nuestro trabajo sufi ciente y estamos 
muy satisfechos de los resultados obtenidos. Una parte relevante de 
nuestro tiempo de estudio ha sido necesario dedicarlo a aprender 
nuevos programas informáticos, como ImageJ, PhotospherU, Qtpsfgui, 
WebHDR, SunTools y otros que hemos ya presentado en nuestro 
texto, en cuanto para nosotros eran desconocidos y no tradicionales 
en la formación de un Arquitecto.
Pensamos que técnicas de análisis fotográfi co serán la base en los 
próximos años para estudios medio ambientales y metereológicos. 
Creemos que con los avances de la técnica digital, fotos y videos 
hemisféricos remplazarán los escáneres de cielo para estudios de la 
bóveda celeste, en cuanto son capaces de dar una mayor cantidad de 
información y con una elevada precisión. Opinamos que el análisis 
de imágenes afi ncará, con mayor frecuencia, estudios de modelos 
informáticos para el control de la luz.   

Finalizamos nuestro trabajo contentos de los resultados obtenidos y 
con ganas de seguir profundizando sobre el tema, a fi n de mejorar el 
método de análisis y hacerlo más rápido y preciso, quizás intentando 
desarrollar un software que permita ejecutar toda   la elaboración en 
un único programa.  
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